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C.Request for New Users Training Exercises

Changes/Revisions Record

This is a living document that is changed as required to reflect system, operational, or
organizational changes. Modifications made to this document are recorded in the
Changes/Revisions Record below. This record shall be maintained throughout the life of
the document.

Changes Made by

xﬁrr:ife"r Date Description of Change/Revision Name/Title/
Organization
V1.0 | 10/01/2020 | New FY 2021 Training Exercises — updated for E.Cobbs/FSD

current FY CSB — Training
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C.Request for New Users Training Exercises

Exercise #1: Login to C.Request

Objectives: e Successfully Login to C.Request

e Access C.Request Home Page
e Understand the Navigation Terms

Instructions: Execute the following steps:

Step

Action

1

» Open up a web browser (Internet Explorer or Google Chrome)
» Go to the C.Suite URL

On the Login Screen:

» Enter your username.

» Enter temporary password
» Select the Subsystem

» Click Submit

Welcome to ComprizonSuite Version 10.2

LOGON MENU

Registration

.~ OPTIONS
Help

NOAA C.SUITE PRODUCTION - VERSION 10.1 (as of 25 JAN 2020

FY20 Year End Schedule:
https://www.corporateservices.noaa.gov/finance/yearend.html

C.Suite Resources:
https://sites.google.com/a/noaa.gov/acquisition-grants/systems/c-suite

T
-

Enter your User ID and Password. * = Required Field

= User ID: | |

= password: | |

* Subsystem: Oc.Request O c.Award

Attention: DO NOT use the BACK button on your browser and DO NOT DOUBLE CLICK on any button or link while in the ComprizonmSuite
application. Neither of these actions are supported and will cause loss of data and unexpected resuits.

Submit

FY 2021 — Version 1.0 1
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Step Action

3 | The Home screen appears.

User: FRANKLIN IDAHO (FFL
Home G

Version: 10.2 Screen ID: NYA

MAIN MENU

User Profile successfully updated.

| SUIn | Hotist | Recenty Accessed || Worksheet | Alerts & Messages |

No new documents.

Navigation Terms

| Standard Menu Bar |

e,

.
Home 4—| Screen Title | e ()

e —— Message/
Notes .

MAIN MENU

Requisition

o ReromtS/sTecEs ety acees || Wores
Document Search

Procurement Search Nng documents.
< SOW Abstract Search -

Menu
Options

Standard Reports.

-~ SYSTEMOPTIONS Y

|~ OTHER SYSTEMS View Tabs

\

Page Area

FY 2021 — Version 1.0 2
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Exercise #2: My Profile

Objectives: e Navigate to my profile

e Add your email address
e Change your password
e Change your signature PIN

e Add Personal Account Codes

Instructions:  Execute the following steps:

You have just received access to C.Request. The first time you log into the system you
will need to update some fields on My Profile. Navigate to My Profile — add your email
address, change your default password and default signature PIN and add Personal
Account Codes.

Step Action
1 From the Home screen:
» Click the My Profile menu option on the Standard Menu Bar
2 The Verify User screen appears.

» Enter your login password
» Click Continue

. User: ABIGAIL ALABAMA (AGA)
Verify User Version: 10.2 Screen ID: NYA

MAIN MENU

~ CREATE * = Required Field
Requisition

~ REPORTS/SEARCHES
Document Search Enter your logon password. Click on the Continue link to edit your User Profile.
Procurement Search

SOW Abstract Search * password: [| ]
Standard Reports

~ SYSTEM OPTIONS

~ OTHER SYSTEMS Continue = Cancel

FY 2021 — Version 1.0 3
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Training Exercises

Step Action
3 The My Profile screen appears.
; User: ABIGAIL ALABAMA (AGA)
My Profile Version: 10.2 Screen ID: UPAR
USER PROFILE DETAIL
MENU * = Required Field
A I ) It

~ OPTIONS

Account Codes User Information

+ SYSTEM OPTIONS ” Code: AGA

OTHER SYSTEMS = First Name: [ABIGAIL] = Last Name: ALABAMA
Title: STUDENT CREQUEST Phone Number: 301-444-3400
Fax Number: |3U1—444—D101 Other Phone:
= Office: NOAA - OCFO E;:‘tia:géddmss for internal [abby.alabama@test noaa gov ]
E-Mail Address For Printing:  [abby.alabama@test.noaa.gov ]
Preferences
Send E-Mal when items are Send E-Mail for Action Alerts: [
routed to Inbox:
Forward Items Routed to my 0 Forward E-Mail to:
Inbox: - !
Customization
Laveut
Cotor
Save = Apply Reset = Cancel

Under the Administration view tab:

» Verify Information entered is correct

> Click the Addresses view tab

Notes:

v"In production, you will verify the information in these fields is correct. These fields
are populated by the information provided by you when you signed up for access to

C.Request.

v In the preferences section, a general requisitioner will only check the box for action
items. Once checked, C.Suite will send you emails when actions either need to be
taken or have been taken (i.e. to whom it was sent to for approval, final approval,

rejected or accepted by CFS, etc.)

v A reviewing or approving official will want to check the box to receive and email

when items are sent to their inbox.

v’ There is also a section that allows you to customize the way C.Request displays on

Screen.

FY 2021 — Version 1.0
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Training Exercises

Step

Action

4 Under the Addresses view tab:

USER PROFILE DETAIL
MENU

Account Codes

SYSTEM OPTIONS Office:

. » OTHER SYSTEMS

Purchase
For:

Contracting

My Profile

sz
QCIO/NISMO/ADSIFIN SYS ADMIN BR
20020 CENTURY BLVD

SM 1202

GERMANTOWN MD 20879

AJ151200 =
OCIO/NSMO/ADS/FIN SYS ADMIN BR
20020 CENTURY BLVD

SM 1202

GERMANTOWN MD 20879

Deliver To: [AJ151200 =]

QCIQ/NSMO/ADSIFIN SYS ADMIN BR
20020 CENTURY BLVD

SM 1202

GERMANTOWN MD 20879

» Verify that the first three address fields are filled out
» Click the Logins/Passwords view tab

DRy Addresoes g SO e e ST e bl LS SO

User: ABIGAIL ALABAMA (AGA)
Version: 10.2 Sereen ID: UPAR

= Required Field

POC: OCIO/ISMO/ADS/FIN SYS /

POC:  OCIOISMO/ADSIFIN SYS ¢

PoC:  OCIO/ISMO/ADSIFIN SYS #

Notes:

v' When first logging into this screen, these fields will be blank.

v In production, you will want to enter all of your addresses here in order for them to
automatically populate on each requisition. This will save you a great deal of time
when processing requests in future.

v You can change any populated address on a requisition to a different one.

FY 2021 — Version 1.0
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Step

Action

5

Under the Logins/Passwords view tab:

» Check the box Change Logon Password

» Check the box Change Signature Password
» Enter & Confirm the New Password

» Enter & Confirm the New Signature PIN

» Click Apply

i User: ABIGAIL ALABAMA (AGA)
My Profile Version: 10.2 Sereen ID: UPAR

USER PROFILE DETAIL
MENU = = Required Field

— - Addresses Authority || Warrant | Logins/Passwords

FPDS-NG

~ OPTIONS
Account Codes

+ SYSTEM OPTIONS FPDS-NG Username [ ]

» OTHER SYSTEMS Logon
* Logon Id: NOAAAGA
Change Logon Password: O

Signature

Change Signature Password: O

Subsystem

Default Logon Subsystem:

Save Apply Reset Cancel

Notes:
v In production the FPDS-NG Username field will be filled in with your email.
v Clicking Apply saves the information and keeps you on the same screen.

v' Clicking Save saves the information and closes the screen.

Once you have clicked Apply,
you will see the following option
in the menu at the left. = OPTIONS

Account Codes

USER PROFILE DETAIL MENU

Click Account Codes under
the Menu Options.

FY 2021 — Version 1.0 6




C.Request for New Users

Training Exercises

Step Action

7 The Personal Account Code Management screen appears.

Personal Account Code Management

PERSONAL ACCOUNT . .
Search Criteria

CODE MENU
Filter on: ( ~] | vl
~ ACTIONS
Create
Delete
Search
SYSTEM OPTIONS Mark Group Name ¢ BOC Code # Account Code

User: ABIGAIL ALABAMA (AGA)
Version: 10.2 Screen ID: PACMR

Reset all Search Fields

+ Active %

User Profile
Mo Personal Account Code records found that meet the filter criteria
OTHER SYSTEMS

» Click the Create menu option

Displaying0-0/ 0

Notes:

easily add them to your requisitions.

v’ This feature allows you to add accounting codes to your profile so that you can more

8 | The Personal Account Code Detail screen appears.

Personal Account Code Detail

PERSONAL ACCOUNT
CODE DETAIL MENU

——— )

Active:

= Group Name:
~ OPTIONS

SYSTEM OPTIONS
User Profile
Account Code Import Entire Account Code
OTHER SYSTEMS
Segment Label Name

Label Value
Bureau Code (2): g

]

Fiscal Year (2):

Project (7):

Task (3):

Fund (4):

Program (8):

Organization (16):

Object Class (8):

e

User Defined (s):

Save Cancel

Supplies Simp)
Enter all values of the ACCS (e.g., bureau, fund, etc.)

022116001-3021000200000000-26182535-000000
Click Save

User: ABIGAIL ALABAMA (AGA)
Version: 10.2 Screen ID: PACDR

* = Required Field

Enter the name you wish to give this ACCS in the Group Name field (i.e.

In this example, use the following ACCS string: 14-21-28LEF28-B00-0001-

FY 2021 — Version 1.0
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Step Action
Notes:
v Each field name has a number in parentheses; this represents the number of
characters that the field must contain
v’ Enter all field values in capital letters
v For any fields that end in zero, you can hold down on the zero on your keyboard;
C.Request knows when to stop
v You can also leave some fields blank (like object class) so that you have a
default template ACCS. This is useful if you often use ACCS codes that have
most of the same information, but may have different Object Class entries.
v' AGO Fee for Service (FFS) now means your ACCS must have either 2517 or
2535 at the end of your object class code
v Pro-Tech object classes will end in 2603
v' NOAALink object classes will end in 0011
9 | You'll be returned to the Personal Account Code Management screen, where
your new ACCS will appear and you’ll see a message at the bottom stating it has
been successfully added.
Personal Account Code Management \E:Jj;r.H%I?ISL(?EL:E?BHPJ‘;TR
( 9| 2l S
JS:}E};EM i Search
Mark All Unn‘1ark All r
D Displaying 1: 1/1
mum Displaying1-1/ 1
» Using the above steps add the following ACCS string for Supplies Non-
Simp: 14-21-28LEF29-P00-0001-022116001-3031000200000000-26182517-
000000
» Click the Home link in the Standard Menu Bar when finished
10 | The Home screen appears.
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Exercise #3: Create a Requisition (Paper)

Objectives: ¢ Navigate through C.Request
e Create a Requisition
e Follow flow chart

Instructions:  Execute the following steps:

Your office is close to running out of copier/fax paper. You need to create a requisition
after getting a quote for 10 boxes that would contain 10 reams per box. The quote you
got from Staples was $6.59 per ream for 70+ reams.

Step Action

1 From the Home screen:
» Click Create Requisition from the Menu Options
MAIN MENU

+ CREATE
Requisition

2 The Requisition PIIN and Name screen appears.

» Choose Document Number from the PICKLIST

» Change the Document Name if you wish. (i.e. [date] PAPER)
» Click Save

isiti ser: A AIL ALABAMA (AGA)
Requisition PIIN and Name \-"g\'si‘crf?:ﬁ;msz\;eer I“D: CREQ
MAIN MENU

= = Required Field
~ CREATE
Requisition

= Document Number: - (A0 ] - [31v] - [T

* Document Name: [NA-AJ2000-21-77772 ]

~ REPORTS/SEARCHES
Document Search
Procurement it Search

SOW Abstract Search
Standard Reports

» SYSTEM OPTIONS
+~ OTHER SYSTEMS

Save || Reset | Cancel

FY 2021 — Version 1.0 9
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Step

Action

Notes:

The user’s codes for their office will show in the first Document Number field.

The document number is made up of the Bureau Code, Office Code, Fiscal
Year and a system generated number.

The Office Codes can be looked up here: Google Sheet - Office Codes

v' A preparer may change the document name to something that is specific to

them; however, there is approximately a 30 character limit. If the preparer
does not want to change it, the system will default the name to the Document
Number.

If changing the Document Name you may want to add a date at the beginning
of the name letting you know when this requisition was created.

v'Any field containing an asterisk (*) is a mandatory field that needs to be

entered.

The Requisition Administration screen appears.

Requisition Administration AL aaA e
REQUISITION SUMMARY | pequisition created successfully.
MENU
~ SECTIONS 4
Summary
Administration * = Required Field
Accounting Administration | Funding | Addresses
Line Items
Forms - -
Notes Nu":i:'f_‘t“’" NA-AJ2000-21-00005 = Requisitien Title: A-AJ2000-21-00005
* Requisition il
~ PROPERTIES Daleq O * Form: Standard Req v
Sharing - " -
Locking o Delvery  ——# * Requesting Office: [NGAA-OCFO |
el
PROCUREMENT Cop:t'::t:ﬂf [ABIGAIL ALABAMA * POC Phone: [301-444-3400 ]

Period of Performance Defaults

Support Documents Dept:
g

History

ACTIONS
Assign PIIN
Cancel
Copy
Delete
Add to Hotlist

Recommended

COR: If not =] X . -
PR . o8

requred . L 17 % primary Technical POC: —

select NCR No

COR required

FINANCIAL

View Status * E-Mail

Address For : E-Mail Address For Internal
+ CREATE Internal Routing:

Routing:
+ SYSTEM OPTIONS Eﬂéﬂﬁ“’n"fSSI:l E-Mail Address For Printing:

Return To Just In

= FCoT ] ]
Number: I:I = FOB: [Destination _ ~ |

+ OTHER SYSTEMS

4B
Code: =

FY 2021 — Version 1.0 10
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C.Request for New Users Training Exercises

Step

Action

3a

On the Administration view tab:

The following fields should be automatically populated based on information in
your Profile:

Requisition Number (system generated)
Requisition Title (although this can still be changed here)
Requisition Date (populates with the current system date)
Form (Should always read Standard Req)

Requesting Office (populated from My Profile and should be filled with
your office)

Point of Contact (populated from My Profile and should be filled with
your name)

POC Phone (populated from My Profile and should be filled with your
number)

On the Administration view tab you will need to:
» Enter the Delivery Date (i.e. MM/DD/YYYY)
» Click the Lookup+ icon for the Recommended COR field

Notes:
v

v

v

The Delivery Date should follow the PALT guidelines.

The Delivery Date for certain items would be when you expect it to be
delivered.

The Delivery Date for items that have multiple option periods should reflect the
end date of the last period.

AGO has the ability to change the delivery date should it need to change due
to PALT issues.

FY 2021 — Version 1.0 11
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4a A new window opens:
@ User LookUp - Google Chrome = m] *
@ crequestdtnoaa.eas.commerce.gov/noaa/serviet/UserLookUp?readonly=N&screen=RA&lookup=RecCor Q
Office: ‘ NOAA - OCFO (My Office) v‘ Reset all Search Fields =
Authority Type: Certification Status:
Filter Criteria: | v ~
Search Close
muum Displaying 1 -4/ 4
Agent - = Certification Certification Certification
Code N Tz = Status Begin Date End Date ez
DARREN NOAA - .
DEB BAK OCFO TRAINING FCO  Certified 02/01/2019 02/28/2025 @
~ ERIN NOAA - PROGRAM . , ,
EKC cOBBS OCFO ANALYST Certified 01/01/2018 01/01/2025 |§|
FARAMNAK NOAA - MANAGEMENT c
EXF EOULADT OCEO ANALYST Certified 10/01/2019 09/25/2025 @
JaeMie MNOAA - . , ,
JDH Hughes OCEO Certified 05/16/2018 05/31/2028 |§|
muum Displaying 1 -4/ 4

The pop-up window automatically has populated your Office and the Authority
type of COR, which allows for a listing of all your CORs for your office. Prior to
selecting one you must review their certification status and begin and end
dates to make sure you’ve selected a valid one.

> Click the Select/¥) icon of the code you want to choose (i.e. EKC)

The selection will populate all the mandatory fields related for the COR on the
screen:

Recommended

CORE If not EKC o) LES,
required

select NCR No

COR required

* Name: ERIN COBBS

- phona 301-444-3706
Number:

Fax Number: 301-444-3401

= E-Mail

Address For

Internal Enn.Cobbs@noaa.gov
Routing:

E-Mail Address

For Printing: Erin.Cobbs@noaa.gov

nomber: 1 &
» Click the Lookup+ icon for the FCOT Number
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Step Action

Notes:

v’ If you do not know who the Contracting Officer Representative (COR) is you can
type in NCR in capital letters and click the refresh icon. The fields below will then
populate with default system information.

v' FCOT Number is replacing FAAPs and information containing that can be found
here: https.//sites.google.com/a/noaa.qov/acquisition-grants/systems/c-bot

5a A new window opens:

@ FCOT Number Look Up - Google Chrome - o X

8 crequestdtnoaa.cas.commerce.gov/noaafservlet/FaapsLockup?readonly=N&screen=FAAPS&lookup=FAAPS &

Filter Criteria: [ ] | vl | w

Search Close

Please enter search criteria and click on 'Search’ to view results.

The filter criteria fields will be blank. Either use the drop-down arrows for each
field to enter your criteria or click Search to bring back all FCOT numbers

@ FCOT Number Laok Up - Goagle Chrome - o x

@ crequestdtnoaa.eas.commerce.gov/noaa/serviet/FaapsLookup?readonly=N&screen=FAAPS&lookup=FAAPS &

Filter Criteria ~| | ~| | qw

Search Close

IR DCD Displaying 1 - 20 / 100
FCOT Number FCOT Description Select

00000 No FCOT Required E|

10 Tast |

10227 Provide technical service within SOD @ MIB Ed]

11 E£S-A Test |

12 Testing @

13 Test 2 |

14 test &

is test - #The Governmer\_t intenqs to procure ABC @

te support the Office C in order to support XYZ
16 Things @
17 IT Testing E| -

Since this is a non-simplified purchase and isn’t a service we can choose the
option for No FCOT Required

> Click the Select¥] icon for the code (i.e. 00000)
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C.Request for New Users Training Exercises

Step Action

Notes:

Any acquisition that is $250,000 or less might be considered a simplified

acquisition and will use 5 zeroes in the FCOTs number field. Do not use more
than 5!

<\

Any acquisition over $250,000 must have a specific FCOTs number.
Primary Technical POC is not a required field.

6 The selection will populate the FCOT field on the screen:
e o @

No FCOT Required

Svhesh N I o~
AR
Code: =

» Click the Lookup+ icon for the UNSPSC Code
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Training Exercises

Step Action
6a A new window opens:
@ UNSPSC Lookup - Google Chrome - m] X
@ crequestdtnoaa.eas.commerce.gov/noaa/serviet/UnspscLookup?readonly=N&screen=UNSPSC&lookup=... &

Reset all Search Fields

~

Search Criteria

UNSPSC Code

UNSPSC Title

]
—

FSC Code

—

| FSC Description |

~

Active Records

UNSPSC Segment |

| eny: O

~
UNSPSC Family | |

~
UNSPSC Class | |

~
UNSPSC Commaodity | |

Search Close

Please enter search criteria and click on 'Search’ to view results.

The filter criteria fields will be blank.

» Check Active Records Only
» Use the drop-down menus and enter the criteria you want to use to locate
the UNSPSC code OR FSC Code

@ UNSPSC Lockup - Google Chrome - ] X
& crequestdtnoaa.eas.commerce.gov/noaa/servlet/UnspscLookup?readonly=N&screen=UNSPSC&lookup=... @&
Reset all Search Fislds

~
~

] FSC Description |

Search Criteria
Contains ~ +

[PAPER]

>

UNSPSC Code FSC Code

UNSPSC Title

Active Records

UNSPSC Segment I | Only:
>
UNSPSC Family I |
~
UNSPSC Class I |
v
UNSPSC Commodity I |
Search Close

Please enter search criteria and click on 'Search’ to view results.

» Click Search to return all codes that match the criteria you are searching
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Step Action

Notes:

v This is a mandatory field. You are not able to enter the FSC code directly;
however, when you select a UNSPSC code, the related FSC Code will populate
automatically.

v If you are unable to find the code in the system, check the DOC website:
https://community.max.qgov/pages/viewpage.action?pageld=696617672

v You will have to register to download the list and the FSC crosswalk.

v If you find a UNSPSC code that you need on the list, fill out this form: UNSPSC
Code Form and submit it so that it can be added to C.Request by the system
administrators.

6b The screen will then display all codes matching what you're searching on:

UNSPSC o UNSPSC UNSPSC UNSPSC UNSPSC FSC g =
Code UNSPSC Title Segment Family Class Commodity Code FSC Description Active Select
14111500 Printing and  Paper Materials Paper products Printing and 9310 PAPER AND i |z|
writing paper and Products writing paper PAPERBOARD
14111507 Printer or Paper Materials Paper products Printing and  Printer or 9310 PAPER AMD Y |z|
copier paper  and Products writing paper copier paper PAPERBEOARD
14111511 Writing paper Paper Materials Paper products Printing and Writing paper 9310 PAPER AND Y |z|
and Products writing paper PAPERBOARD
14111514 Paper pads or Paper Materials Paper products Printing and  Paper pads or 9310 PAPER AND Y |z|
notebooks and Products writing paper notebooks PAPERBEOARD
14111530 Self adhesive Paper Materials Paper products Printing and  Self adhesive 9310 PAPER AND i |z|
note paper and Products writing paper note paper PAPERBEOARD
14111703 Paper towels Paper Materials Paper products Personal paper Paper towels 9310 PAPER AND Y |z|
and Products products PAPERBEOARD
14111705 Paper napkins Paper Materials Paper products Personal paper Paper napkins 9310 PAPER AND i |z|
or serviettes  and Products products or serviettes PAPERBEOARD
14121500 Paperboard Paper Materials Industrial use Paperboard 9310 PAPER AMD Y |z|
and packaging and Products  papers and packaging PAPERBEOARD
papers papers
14121600 Tissue papers Paper Materials Industrial use Tissue papers 9310 PAPER AND i |E
and Products  papers PAPERBEOARD

> Click the Selectl¥ icon of the code you want to choose (i.e. 14111507)
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C.Request for New Users Training Exercises

Step Action
7 The screen will return with the UNSPSC and FSC codes populated:
* UNSPSC Code: 14111507 | &
Printer or copier paper
9310
* FSC Code: PAPER AND PAPERBOARD
* Purpose
You have characters remaining for your input.
» Enter the Purpose (i.e. TO PURCHASE FAX/COPY PAPER)
.TO PURCHASE COPY/FAX PAPER FOR THE OFFICE
* Purpose
You have [1959 characters remaining for your input.
Contract Number:
Notes:
v' Contract Number and/or Delivery Number fields can be used if modifying an Award
Number.
v' Contract Number field can be used if purchasing from GSA
8 The next field to be entered is the Suggested Vendor:

Suggested Vendor: Py
Vendor Name:

» Click the Lookup# icon for the Suggested Vendor field
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Step Action
8a A new window opens:
@ Vendor LookUp - Google Chrome = O *
8 crequestdinoaa.eas.commerce.gov/noaa/servlet/LookUp?readonly=N&screen=RA&Ilookup=Vendor @
Reset all Search Fields
Country: [UNITED STATES v)
Search Criteria: | V| Evnzilg_ilns |
Filter Criteria: Contains | |
Search Close
Please enter search criteria and click on 'Search’ to view results.
» Select Vendor Name in the Search Criteria field
» Enter Staple in the Begins With field
» Click Search
Notes:
v If you are unable to find the vendor, change the Country drop-down selection to
ALL and click Search again.
8b The system will bring back all available options matching the criteria you used

to search:

Ve;l[(}ior Vendor Name City State/Province Tax ID DUNS DoDAAC Select

00006041 STAPLES, INC. KAHUKU HI 204870168 624650235 |E

e Displaying1-1 /1

> Click the Select¥ icon of the code you want to choose (i.e. Staples)
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Step Action

Notes:

v If you click on the Vendor ID link, a new window opens displaying the details of
the vendor. Doing this does not select the vendor.

v' Selecting the vendor does not mean acquisitions will use that vendor to order
this item.

v' When searching in C.Request, the more values you enter, the fewer entries will
be returned. Use the fewest values you need to locate the Vendor.

9 The screen will return with the Suggested Vendor field populated:

Suggested Vendor: 00006041 =
Vendor Name: STAPLES, INC.

Save  Apply Reset Cancel

At this time if you click Save or Apply you'd get error messages

Funding - Funds Certified By is 2 mandatory field.
Funding - Authorized By is a mandatory field.
Funding - Agency Identifier is 3 mandatory field.
Funding - Main Account is a mandatory field.

Apply would keep you on the same page/tab and Save would take you to the
next mandatory field. Neither will actually save any data until all mandatory
fields have been filled in.
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Step

Action

10

Click on the Funding Tab (if Save didn’t already take you there):
* = Required Field

IGREESHCNN  runding SSEEUSCSERCN

Funding Information

Authorization

= Bona Fide Need Certifier (BFNC) ( J

* Fund Certifying Official (FCO) {Must Not Match BFNC)I | -

Treasury Account Symbol
* Agency S * Main s Sub s
Identiﬁer:l Account I:I Account I:I
Initiative:

Save Apply Reset Cancel

» Click the Lookup+ icon for the Bona fide Need Certifier field

10a

A new window opens:

@ User LookUp - Goagle Chrome: - m} x
@ crequestdtnoaa.eas.commerce.gov/noaa/servlet/UserLookUp?readonly=N8iscreen=RA8&oockup=Authoriz.. &

Office: [NOAA— QCFO (My Office) v] Reset all Search Fields

Authority Type: ‘AII "l

Filter Criteria: | ~ | v

Search Close

RN Displaying 1 - 26 / 26
Agent Code Name Office Title Select
800 KELLI DAWSON MOAA - OCFO MANAGEMENT AMALYST @
ABM ADRIAM MICHIGAN MOAA - OCFO STUDENT CREQUEST @
AGA ABIGAIL ALABAMA MOAA - OCFO STUDENT CREQUEST @
ATM ADDISON MAINE NOAA - QCFO STUDENT CREQUEST @
AWA ABIGAIL ALABAMA NOAA - OCFO STUDENT CREQUEST @

BAC BLYTHE CALIFORNIA NOAA - QCFO STUDENT CREQUEST @

onc o E o ADTAR MAAA - AFCA  STIHRCMT ADEAIIEST = =

As you can see this lookup does not have the Bona Fide Needs Certifier as a
search criteria. So you’ll need to know who you’re searching for or typing in the
field.

Search on your training name

Click Search

Click the Select¥ icon

Click the Lookup# icon for the Funds Certifier field
Select Darren Bak

YVVVY
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C.Request for New Users

Training Exercises

Step Action
11 The fields will be filled out:
Authorization
* Bona Fide Need Certifier (BFNC) [ABIGAIL ALABAMA |-

* Fund Certifying Official (FCO) (Must Not Match BFNC)[DARREN BAK |-

Next onto the next section:
Treasury Account Symbol

* Agency * Main
Identifier Account

In the Treasury Account Symbol section, enter information in the following
fields:

Agency Identifier (i.e.13)
Main Account (i.e. 1450)

Treasury Account Symbol

* Agency * Main '
Identifier 13 Account 145D|

> Click on the Addresses tab

Notes:
v' Please make sure to use the look up icons to search on these fields. Do NOT
type them.
v' The Sub Account and Initiative fields are currently not being utilized.

FY 2021 — Version 1.0

21




C.Request for New Users

Training Exercises

Step

Action

12

All the addresses have been populated from my profile, if added there:

ISR RN < ddresses

* Purchase
For:

* Deliver To:

Ultimate
Destination:

Contracting
Office:

» Scroll down to view/modify all of the fields.

=
A 00 IS

OCIO/NSMOIADS/FIN SYS ADMIN BR
20020 CENTURY BLVD

S 1202

GERMANTOWN MD 20879

[ &
QCIONSMO/ADS/FIN SYS ADMIN BR
20020 CENTURY BLVD

S 1202

GERMANTOWN MD 20879

AJ151200 pog
OCIO/NISMO/ADS/FIN SYS ADMIN BR
20020 CENTURY BLVD

SM 1202

GERMANTOWN MD 20879

AJ151200 pog
OCIONSMO/ADS/FIN SYS ADMIN BR
20020 CENTURY BLVD

S 1202

GERMANTOWN MD 20879

Notes:

v' Addresses automatically fill out from your Profile.

v'If any address needs to be changed, it can be done here for this requisition.

v' Use the lookup icon to search for a new address.
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Step Action

12a | At the bottom of the screen is a non-mandatory field in the Administration
screen, however it will be mandatory on the CLINSs.
Supplemental
Address
Information
(Name/Room#):

You have characters remaining for your input.
Save  Apply Reset = Cancel

» Enter “N/A”
» Click Save

12b | If any errors are found in the Administration screen they will show in the

message area like the following:

Adminiztration -Delivery Date mustbe inthe format MMDDAYYYY, Invalid Day entared,

» Fix them and click Save again

Notes:
v" You may have to use the scroll bar to view all the mandatory fields.

v' Clicking Save to save your changes will only work after all mandatory fields
have been entered.

v Clicking Apply on each tab will not save changes unless all mandatory fields
have been entered.

v If Administration screen mandatory fields are not filled out and saved prior to
closing out the requisition, you will be unable to locate it on your Hotlist or
Recently Accessed view tables. It will only be able to be found using the
Worksheet search.
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Step Action

13 The Requisition Summary screen appears:

User: ABIGAIL ALABAMA (AGA)

Requisition Summary Version: 10.2 Screen ID: RSM

REQUISITION SUMMARY | Roquisition successfully updated.

MENU
4
Summary Administration
Administration
f““::t'”g purchase For: 0CIO/ISMO/ADS/FIN SYS ADMIN BR AJ151200 OCIO/ISMO/ADS/FIN SYS ADMIN BR
ine Items )

Forms Delivery Date: 10/30/2020
Notes Point of Contact: ABIGAIL ALABAMA

Purpose: TO PURCHASE COPY/FAX PAPER FOR THE OFFICE

Document Status: Unsubmitted
Sharing P t Status: Unsubmitted
Locking rocurement Status: nsubmitte

Account Summary
Period of Performance Defaults

Support Documents

History Number of Codes Assigned to Line Items: o Number of Default Codes:
percent Allocated: 0% Total Default Percentage: 0%
Total Quantity Allocated: o
é“‘g”l PIIN Total Cost Allocated: $0.00
ancel
Comy Base Cost Allocated: £0.00
Delete Option Cost Allocated: s0.00
Add to Hotlist No Financial Transaction Information.
Manage Reviewers/Approvers
Line Item
View Status
Number of Line Items: 0
F= CREATE Y Total cost: $0.00 Base Amount: £0.00 Option Amount: $0.00
Notes

Return To Just In

» OTHER SYSTEMS No Motes

Project

Review and Approval

» Click Add to Hotlist from the Menu Options
» A message comes back

Reguisition added to Hot List successfully.

» Click Line Items from the Menu Options

Notes:

v' The Requisition Summary screen is the “home” screen for the requisition. It
displays all information pertaining to the requisition at a summary level.
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Step Action

14 The Requisition Line Item Management screen appears:

Requisition Line Item Management e MBI AL e
REQUISITION LINE ITEM

MENU Search Criteria Reset all Search Fields

Filter on: | ~] v |
> ACTIONS
Create CLIN
Create SubCLIN
Copy
Cancel
Delete Search

Result Sorted By: Line Item No.
Global Replace

Renumber Single View Conformed Requisition Line Items
Renumber Range
Period ofPeﬁol?mance Mark I;‘I % Description * Qty $ UL # Cost # Option % Pricing % Action # RRILT %

Status
Mo Line Item records found that meet the filter / search criteria.

From Any Document
Spreadsheet
Check Import Status

Spreadsheet

Summary

» Click Create CLIN from the Menu Options
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Training Exercises

Step

Action

15a

The Requisition Line Item Detail screen appears:

Requisition Line Item Detail User: ABIGAIL ALABAMA (AGA)

REQUISITION LINE ITEM
DETAIL MENU

Version: 10.2 Screen ID: RLID

* = Required Field

Administration | S IGEHCNN

= Line Item No

* Qty
~ SYSTEM OPTIONS
Line Items
Summary Header:

+ OTHER SYSTEMS

= Description:

= UNSPSC Code:

UNSPSC Title:

* F/PSC Code:

FSC Description:

Receiving Office
Mumber:
Modification LT
Action:

Total Cost:
You have characters remaining for your input.
You have characters remaining for your input.
Mot Separately O
Priced: —

14111507 & Stock Ttem:

Printer or copier paper

9310
PAPER AND PAPERBOARD

I

[ v

Save Apply Reset Cancel

From the Administration view tab (Line 0001):

V V V V V V

Enter the Qty (i.e. 100)

Enter the Ul (i.e. REAM)

Enter the Cost (i.e. 6.59)

Enter the Description (i.e. FAX/COPIER PAPER)

Enter the Receiving Office Number (i.e. copy an Address Code)
Click on the Address tab

Notes:

v' The UNSPSC & FSC for the line item will default from the Administration

Screen.

v If any code needs to be changed, use the lookup icon or enter the new code in

that field.

v' Header information entered on this screen appears on the printed form above
the line information.
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C.Request for New Users Training Exercises

Requisition Line Item Detail Jser: ABIGAIL ALABAMA (AGA)
REQUISITION LINE ITEM | e Item successfully added.
DETAIL MENU
~ TOOLS 4
Accounting
= = Required Field
- AcTioNs L. Administration | Adaress ;
Create SUbCLIN Chicne
* Delivery Date: 10/30/2020 ‘fﬂd
+ SYSTEM OPTIONS
e s * Deliver To: AJ151200 08
OCIO/ISMO/ADS/FIN SYS ADMIN BR POC:  OCIQNSMOIAI
~ OTHER SYSTEMS 20020 CENTURY BLVD

YVVVYYYY

S 1202
GERMANTOWN MD 20879

Supplemental Address
Information{Name/Room=):

You have characters remaining for your input.

Foe:

Save Apply Reset Cancel

Verify/Modify Delivery Date

Verify/Modify Addresses

Copy the Address Code

Go back to the Administration view tab

Paste the Address Code in the Receiving Office Number
Click Apply

Click Accounting from the Menu Options

Notes:

v

v

The Address Tab information is extracted from the information provided on the
Administration screen.

If the delivery date is different for the line compared to what was added on the
Administration screen, make the change here.

Each line item’s address area can be edited to have its own shipping
information and delivery date(s).

Supplemental Address Information is mandatory on CLINs

The Option Tab should only be used when dealing with base and option
years.

Apply needs to be done here because it will save our line information and give
us the ability to then add line accounting.

If save was done instead of apply, the user would have to re-open the line in
order to see the Accounting option for the line.
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C.Request for New Users

Training Exercises

Step

Action

16 The Account Code Management screen appears:

ACCOUNT CODE MENU

Requisition Line Item Account Code Management

Line Item No.: 0001, FAX/COPIER PAPER

User: ABIGAIL ALABAMA (AGA
Version: 10.2 Screen ID:

Result Sorted By: Account Code

Create

Edit b Criteri

Delete Search Criteria Reset all Search Fields
Search Criteria [ ~]) | ~ |

Summary

Line Items Search

.~ OTHER SYSTEMS . .
Line Item Total: 659.00 Total Cost: $0.00 Total Percent: 0% Total Quantity: 0.00

Mark All | Unmark All
EIEN D00 Displaying 0-0 / 0
Mark Account Code ® Cost % Quantity # Percent L BOC %
Na Account Code recards found that mest the filter criteria
EIEN DT Displaying 0 -0 / 0
» Click Create from the Menu Options
17a | The Account Code Detail screen appears:
Account Code Detail Version: 10.5. Sereen Tbe
,’:ECSSUNT CODEDETATL Line Item No.: 0001, FAX/COPIER PAPER = = Required Field
s srste Bureau Code (2):  [___)'1mport Entire Account Code
s L s
OTHER SYSTEMS Project (7): —
Task (3): —
Fund (4): "
S S—
Organization (16): |:| !
Object Class (8): 1
User Defined (6): 1
Allocation By:
Percent 0.00 Cost: Quantity 0

Save

Apply Reset Cancel

» Click the “Import Entire Account Code” link
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Step Action

17b | A new window will open:

@ Account Code LookUp - Google Chrome: = O s

& crequestdtnoaa.eas.commerce.gov/noaa/serviet/LookUp?readonly=N&screen=ACD&lookup=AccountCode @&

Reset all Search Fields
Search Criteria: [Account Table ~] -

Filtercriteria:‘ V| ‘ V‘ | I

Search Close

Ly Displaying0 -0/ 0
Group Name Account Code BOC Select
No Records Found
CIRN DAY

Displayingo -0/ 0

The default will be Account Table. Click on the drop-down Search Criteria
field and select Personal Account Codes. Click Search.

@ Account Code LookUp - Google Chrome = O X

8 crequestdtnoaa.eas.commerce.gov/noaa/serviet/LookUp?readonly=N8&screen=ACD&lookup=AccountCode &,

S Reset all Search Fields
Search Criteria: \ Personal Account Codes V\

FilterCriter‘ia:‘ V| | v| |

Search Close

i) uum Displaying 1 -2 / 2|
Group Name Account Code BOC Select

SUPPLIES SIMP 1421281 EF28B000001022116001302100020000000026182535000000 @

gl["‘;;LIES MNON 142128 EF29P0000010221160012303100020000000026182517000000 @

M ]

Displaying 1 -2 / 2

All Account Codes entered on your Profile appear here.

> Click the Select¥ icon for the code you want to select
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Step

Action

17¢c

The fields then will populate with the values from the account code selected.

i User: ABIGAIL ALABAMA (AGA)
Account Code Detail Version: 10.2 Screen ID: RACD

ACCOUNT CODE DETAIL

User Defined (6):

MENU Line Item No.: 0001, FAX/COPIER PAPER = = Required Field
~ SYSTEM OPTIONS Bureau Code (2): 'Import Entire Account Code
Accounting
Ei:rsrlﬂtz;rvys Fiscal Year (2): !

+ OTHER SYSTEMS Project (7): '
Task (3): )
Fund (4): !
Program (2): !
Organization (16):
Object Class (8): )
‘

Allocation By:

Percent:

=)

00 Cost: 0 Quantity: 0

Save Apply Reset Cancel

» Select Allocation By (i.e. Cost)
» Enter Cost (i.e.659.00)

» Enter Quantity (i.e.100.00)

» Click Save

Notes:

v' Line Accounting allows a user to enter the amount on the ACCS by Percent,
Cost and/or Quantity.

v" Depending upon which one you choose, different fields will need to be entered.

v" If using Cost, you will also have to enter the Quantity and vice versa. Cost is
option most commonly used
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Step

Action

18

The Account Code Management screen appears with the accounting now
listed.

PR User: ABIGAIL ALABAMA (AGA)
Requisition Line Item Account Code Management Version: 10.2 Screen ID: RAC
ACCOUNT CODE MENU Account Code successfully added.
Create 4
Edit
Delete Line Item No.: 0001, FAX/COPIER PAPER
Summary Search Criteria Reset all Search Fields
Line Items Search Criteria [ ~] | v |
.~ OTHER SYSTEMS
Search
Line Item Total: 659.00 Total Cost: $6.59 Total Percent: 1% Total Quantity: 100.00
Result Sorted By: Account Code
Mark All | Unmark All
by Displaying1-1/1
Mark Account Code ¢ Cost ¢ Quantity ¢ Percent ¢ BOC ¢
[0 1421281FF28B0000010221160013021000200000000261 5000000  $6.59 100.00 1
IOy Displaying 1 -1/ 1

» Click Summary from the Menu Options
» Click Forms from the Menu Options
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Step Action

19 The Requisition Form Setup screen appears:

User: ABIGAIL ALABAMA (AGA)

Requisition Form Setup Version: 10.2 Screen ID: RFS

REQUISITION SUMMARY

MENU * = Reguired Field
~ SECTIONS

Summary Line Item Print Options

Administration

Accounting [0  Accounting Codes

I;:;nlstems O Cost of Line Item Applied to the Account Code
Notes [ Delivery Address
O Delivery Date

PROPERTIES []  FOB Designation
Sharing -
Locking [l Stock Number

PROCUREMENT Document Options
- » PROCUREMENT
Period of Performance Defaults _
Support Documents (] Exclude Unexercised Options from Totals
History

Header Information

ACTIONS
Assign PIIN Information:
Cancel
Copy

Delete
Add to Hotlist
Manage Reviewers/Approvers

FINANCIAL

View Status You havel:l characters remaining for your input.

CREATE Form Setup Status

|+ SYSTEM OPTIONS  [Dete lastUpdated:
Return To Just In Time Last Updated:

Agent Last Updated:
OTHER SYSTEMS

Save Apply View Form Reset Cancel

» Click the Accounting Codes checkbox

» Click the Cost of Line Item Applied to the Account Code checkbox
» Click the Delivery Address checkbox

» Click the Delivery Date checkbox

» Click View Form

Notes:

v' Each box that is checked displays information on the printed copy of the
requisition.

v" You must check at least one box in the Line Item Print Options section. Any
others are optional.

v'Header information appears above the line items on the printed form.
v Click Apply if you wish to keep the options checked for this requisition.
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Step Action

Notes:

v' Each box that is checked displays information on the printed copy of the
requisition.

v' Header information appears above the line items on the printed form.

v’ Click Apply if you wish to keep the options checked for this requisition.

20 A warning message appears:

creguestdtnoaa.eas.commerce.gov says

This will open the form in PDF format in a new browser window,

To return to the original form, please close the new window

» Click OK

21 A new tab/window will open showing your requisition form in Adobe (pdf)
format. You can then print or save your document.

REQ. DATE |PAGE OF
REQUISITION FOR SUPPLIES/SERVICE
a ocrozzo20] 1 |2

TREQUISITION NO 2 PRIORITY 3 AMOUNT 4 DELIVERY DATE 5 FUNDS AVAILABLE
NA-AJ2000-21-00005 659.00 OCT 30, 2020 x [Funds Available | [SAF
6. CONTACT (Mame and Phone) 7. AUTHORIZED BY 8. CONTRACT/IDC NO.
ABIGAIL ALABAMA, 301-444-3400 ABIGAIL ALABAMA
5. PURCHASE FOR AJ151200] 10. DEPT 1. FUND | 12. PROJECT 13.FSC
OCIONSMO/ADS/FIN SYS ADMIN BR 9310
20020 CENTURY BLVD
SM 1202 14. ACCOUNTING AND APPROPRIATION DATA
GERMANTOWN MD 20879 See Schedule

16a. RECOMMENDED COR

ERIN COBBS
15a. DELIVER TO

AJ151200 [T, FUND CERTIFYING OFFICIAL

OCIONSMO/ADS/FIN SYS ADMIN BR DARREN BAK
20020 CENTURY BLVD
SM 1202 17. VENDOR 00006041
GERMANTOWN MD 20879 STAPLES. ING.

45 CEDAR LANE
15. SUPPLEMENTAL ADDRESS ENGLEWOOD NJ 07831
A
18. PURPOSE
TO PURCHASE COPY/FAX PAPER FOR THE OFFICE

» Close the tab/window

» Click Support Documents from the Menu Options (found under
Procurement)
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Step Action

Notes:

v' A Supplementary Page may appear with the print out. Do not worry about it.
v' How the document appears will depend on how the browser was set up.

22 The Support Document Management screen appears. Attach any supporting
documentation in electronic format that you think is important for this
requisition.

User: ABIGAIL ALABAMA (AGA)
Support Document Management Version: 10.2 Screen ID: SUPDOC
SUPPORT DOCUMENT
MENU Search Criteria Reset all Search Fields
Group Names: (A ~] Document Names:
~ ACTIONS .
Create Filter on: [ v | >l ]
Delete View S rt D ts for: | Entire Py -
Set Final (BT SRR IEEITIET S E7E ntire Procuremen
Set Draft Search

~ TOOLS

Mark All | Unmark All
« SYSTEM OPTIONS

Summary QIR Displaying 0 - 0 / 0

~ OTHER SYSTEMS Mark Document Title * . * La_st L] File Name/Location L] ST * Sl ¢ Modification ¢
on Modified Doc# Type

No Support Document records found that meet the search / filter criteria

ek Displaying0-0/0

» Click Create from the Menu Options

22a | The Support Document Detail screen appears.

Support Document Detail

SUPPORT DOCUMENT DETAIL .
MENU * = Required Field
Document Information

. = SYSTEM OPTIONS
Support Document Managsment = Titles [ )
Summary Group Name: e
OTHER SYSTEMS COR File |
. w OTHERSYSTEMS

Contracting Professional File |

Description/Comments:

You have characters remaining for your input.
Attached On:
Last Modified: 10/02/2020
Attached For: REQUISITION
NA-AJ2000-21-00005

[ include in procurement package to be delivered to Vendor
Related Dates

Document Location

O Enter Hardcopy Location
® Upload Existing File
O Create New File Using Template

Path/Filename: Choose File | No file chosen

File Uploaded:

Save || Apply | Next || Reset | Cancel
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Step Action

22b | > Enter Title (i.e. SPECS)
> Click [Bewse.. | by Path/Filename
This opens a dialog box that allows you to select the file you want to attach to

the requisition. Attached files should have additional information pertaining to
the requisition, such as an e-quote, or specifications for the item.

& Open *
= v 4 e« _ 2020 » Materials » C.Request » Support Docs v | O Search Support Docs yel
Qrganize New folder v ™ @
Publish ol Mame Date modified Type Size
Recertificatio 1% QUOTATIONEX4.docx 12772 Microsoft Word D... 31K3
Recycle Bin 0= SoleSourcebxd.dooe 1 Microsoft Word D... 17 KB
Scanned ARs "L SPECSExd.pdf 11/ Adobe Acrobat D... S0 KB
TRAIMNING M= STATEMENTOFNEEDEXd. docx 1172772 Microsoft Word D... 14 KB
_CBS Trainir
2020
Calendar
Captivat:
CLC
Material:
BOP
C.Requ
Suppt
- v
File name: ~| [ AlFiles ¢ -

» Once the file has been highlighted, click Open
» Once the file has been added, click Save
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Step Action

22c | The Support Document Management screen appears now showing the
support document.

User: ABIGAIL ALABAMA (AGA)
Support Document Management Version: 10.2 Screen ID: SUPDOC
SUPPORT DOCUMENT Support Document successfully added.
MENU
~ ACTIONS 4
Create
Create Search Criteria Reset all Search Fields
Set Final Group Names: [All ~] Document Names:
Set Draft
Filter on: | v‘ | v‘ I I
E=CTOOLSEi vView Support Documents for: | Entire Procurement v
~» SYSTEM OPTIONS Search
Summary Results Sorted By: Document Title Ascending
OTHER SYSTEMS

Mark All | Unmark All

IRy Displaying1-1/1

Mark Document Title * Rutached % Last

Source ,  Source
on Modified

* File Name/Location . Doc# Type

% Modification ¢

NA-AJ2000-21-

O seecs 10/02/2020 10/02/2020 SPECSEx4.pdf 00005

REQ

Iy Displaying1-1/1

» Click Summary from the Menu Options
» Click Manage Reviewers/Approvers from the Menu Options

Notes:

v' Support document file names should not have any special characters or
spaces.

v The file name should not be longer than 20 characters.

v If you have multiple documents with different file extensions (xls, doc, pdf) be
sure to rename them different file names, otherwise you will receive error
messages.

v' Best supported documents extensions: .txt, .doc/.docx, .xIs/.xIsx, & pdf.
v" You will need to load each document separately.
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Step Action

23 The Requisition Review & Approval Management screen appears. This is
where you will set up the routing path for your document.

Requisition Review & Approval Management Version: 10.2 Secreen ID: RAM

REQ REVIEW & APPROVAL .
i i Reset all Search Fields
MGMT MENU Search Criteria Fesel afl Searcn Flelds

Route Order: ( <] | |

~ ACTIONS
Add User Reviewer Type:

Filter on:

] ~I

Search

Import Route List Model

ISNORTIONSSSSN— | mar Route o Address To of Reiewege) Appraxaliy Viewiiy Kecctvedpol Pt Status ¢ Comments &

Summary Order Type Required * Only Date Updated

~ OTHER SYSTEMS No records found that meet the search / filter criteria

» Click Add User from the Menu Options

Notes:

v Offices that have set up route models can select IMPORT ROUTE LIST
MODEL.

v If an office would like a Route List Model set up, because their
reviewers/approvers do not change, will have to contact the NOAA Client
Services Help Desk to do so.
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Step

Action

24

The Requisition Reviewer Detail screen appears. It is here where you will be
entering your information pertaining on how your requisition will route through
the system.

i i User: ABIGAIL ALABAMA (AGA)
Reviewer Detail Version: 10.2 Screen ID: RD
REVIEWER DETAIL MENU
= = Required Field
~ SYSTEM OPTIONS

Revien and Approva - Reviewer : o

Summary
Reviewer Name:
Title:

* Receiving order:

Priority: O

» OTHER SYSTEMS

Approval Required: O] Carben Copy:

View Only: ]

Enter or Search for the Reviewer Code (i.e. Pauline Garcia)
Leave the Receiving Order the number as is

Make sure Approval Required radio button is selected
Check the View Only checkbox

Click Save

YV V V V VY

Notes:

v If entering the code, make sure to click the Refresh Icon to make sure you
have the correct person entered in the field.

v' C.Request automatically creates each “receiving order” number in increments
of 10.

v If you need additional people to review before the final approval you may enter
them as 10, 11, 12, etc.

v" If you have a reviewer prior to an approver, you will need to select Carbon
Copy. That will automatically change to view only.

v’ A Carbon Copy can only be completed at a level after an approval one has
been completed.

v All approval levels, except for the FCO level, should have the Approval and
View Only checkboxes checked.

v' If the document is already committed, you will not have to check the View Only
checkbox for the approvers.
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Step

Action

25

The Requisition Review & Approval Management screen appears with the
first reviewer/approver showing.

Requisition Review & Approval Management

REQ REVIEW & APPROVAL | peviewer is successfully saved.

User: ABIGAIL ALABAMA (AGA)
Version: 10.2 Screen ID: RAM

£

MGMT MENU
~ ACTIONS
Add User .
add Team Search Criteria Reset all Search Fields
Edit Route Order: [ ~] |
Delete
Forward Reviewer Type:
Release . .
Recall Filter on: \ ] |
ToOLS Search
Result Sorted By: Route Qrder, Reviewer Type
+ OPTIONS
Summary
OTHER SYSTEMS Import Route List Model
-
ey Displaying1-1/1
Route Reviewer Approval View Received Last
Mark order % Address To % Type Required only Date * updated Status % Comments #
. - 10/02/2020
[ 10 PAULINE GARCIA Individual A Y 09:56:54
e by Displaying1-1/1

You also need to add the FCO to the routing list:

>

>
>
>
>

>

Select Add User on the Actions Menu

Enter or search for the Reviewer Code (i.e. Darren Bak)
Leave the Receiving Order the number as is

Make sure Approval Required radio button is selected

If the Approval Required radio button is selected, DO NOT check the View

Only checkbox
Click Save
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Step

Action

26

The Requisition Review & Approval Management screen appears with the
reviewers/approvers showing.

User: ABIGAIL ALABAMA (AGA)

Requisition Review & Approval Management Version: 10.2 Secreen ID: RAM

REQ REVIEW & APPROVAL | peviewer is successfully saved.

MGMT MENU
~ ACTIONS 4
Add User
T Search Criteria Reset all Search Fields
Edit Route Order: ( v ]
Delete
Forward Reviewer Type:
Release . .
Recal Filter on: \ ] )
T Search
Result Sorted By: Route Order, Reviewer Type
OPTIONS
Summary
OTHER SYSTEMS Import Route List Model
ey Displaying1-2/ 2
Route Reviewer Approval View Received Last
Mark order * Address To # Type Required only Date updated * Status # Comments &
— - 10/02/2020
U 10 PAULINE GARCIA Individual A Y 09:56:54
M e 10/02/2020
J =20 DARREN BAK Individual A N 10:16:41
ZIRIDCY Displaying1-2/ 2

You may not have the capability to release the document through the routing
process. You will have to share the document with the BFNC in your office.
Each office operates under its own policy regarding releasing or sharing
documents, so check you process before either releasing or sharing.

If you are in an office that allows you to commit the document, you will want to
do the sharing first, because after the commitment has been accepted, you will

be unable to share the document.

» Click Summary from the Menu Options
» Click Sharing in the menu options

27 The Share Permissions screen appears:

Share Permissions

SHARE PERMISSIONS N
Search Criteria

User: ABIGAIL ALABAMA (AGA)
Version: 10.2 Screen ID: CSHRUSR.

Reset all Search Fields

MENU
Status: Unshared
e issi v
add Team perr All v
Add U Filter on: [ ~| | ~ |
Search
Full-4
_!‘:T‘D:GLS— Mark All | Unmark All
Unshare
Mark Code * Name % Team % Share Permission %

~ OPTIONS

Summary Mo Shared User records available.

OTHER SYSTEMS

» Click Add User
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Step Action

28 The Select Users for Sharing screen appears:

i User: ABIGAIL ALABAMA (AGA)
Select Users for Sharing Version: 10.2 Screen ID: SUSSHR
SELECT USERS FOR
SHARING MENU Office Name:  [All ~) Reset all Search Fields
User Role: | v
~ ACTIONS
Addy/Select Search Criteria: | ~| ~
SYSTEM OPTIONS
Share Permissions —

Summary
Results Sorted By: Permissions Ascending

OTHER SYSTEMS ey Displaying 1 - 30 / 1876
Permissions % Code % Name L4 Title % Office Name %

O Full-Access [ view-only 000 Requisitionor . NOAA - DAR

O Full-Access [ view-Only 014 DEBBIE RIVERA ADMINISTRATIVE QFFICER NOAA - NESDIS

[ Full-Access [ view-only 017 MARY ORTIZ SUPPORT SERVICES SPECIALIST NOAA - NMAO

[ Full-access [ view-only 019 JAMES GOUDOUROS IT SPECIALIST NOAA - NESDIS

O Full-access [ view-only 025 REGINA ANN MURRAY ADM SUP SPECIALIST NOAA - NESDIS

[ Full-access [ view-only 034 PAUL PEGNATO ENGINEER NOAA - NESDIS

O Full-Access [ view-Only 037 IDA HAKKARINEN Physical Scientist EEéSTUIIQﬁST;ED

[ Full-access [ view-only 039 TERRANCE TIELKING Chief, DM & CO Branch NOAA - NESDIS

0 Full-Access  [J View-Onlv 044 JOYCE VOYLES SENIOR ACTIONS OFFICER NOAA - NESDIS

» Use the Search Criteria fields to locate the BFCN for your office (i.e. EKC)
» Click Search

Notes:

v Full-Access means the person you are sharing it with can change data on the
document.

v' View-only will only allow the user to view not edit/change it.
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Step Action

29a | Your search results appear:

N User: ABIGAIL ALABAMA (AGA)
Select Users for Sharing Version: 10.2 Screen [D: SUSSHR
SELECT USERS FOR
aHARTNG HEN Office Name:  [A1 <) Reset all Search Fields
User Role: [ v
~ ACTIONS
Add/Select Search Criteria: Code v| [Contains v | [EKC
SYSTEM OPTIONS
Share Permissions Search
Summary
Results Sorted By: Permissions Ascending
~ OTHER SYSTEMS muum Displaying1-1/1
Permissions % Code % Name & Title & Office Name L
[J Full-access O View-Only EKC ERIN COBBS PROGRAM ANALYST EAD-Norfolk-SAP
ey Displaying1-1/ 1

» Check the checkbox for the type of sharing permission (i.e. Full-Access)
» Click Add/Select

The checkbox will be replaced with an asterisk (*)

= Full-Access View-Only EKC ERIN K COBBS PROGRAM ANALYST NOAA - OCFO

» Click Summary from the Menu Options

» Click Manage Reviewers/Approvers from the Menu Options

Notes:

v If you do not have the BFNC role, you would close out this document and
move to another one. You would also let the BENC know that the document
has been shared with them.

v If you do have the BFNC role, the sharing permissions would not be necessary
and you could release the routing list.

v For this exercise, we will release the document for approval but the FCO will
be committing and submitting.
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Step

Action

30

The Requisition Review & Approval Management screen appears with the
routing list showing:

User: ABIGAIL ALABAMA (AGA)

Requisition Review & Approval Management Version: 10.2 Sereen ID: RAM
REQ REVIEW & APPROVAL "
MGﬁT MENU Search Criteria Reset all Search Fields
Route Order: ( <] ] |
~ ACTIONS
Add User Reviewer Type:
Add Team
Edit Filter on: [ v ~
D::sfearr Search
Rel
R:;?‘SE Result Sorted By: Route Order, Reviewer Type
~ TOOLS
Import Route List Model
OPTIONS
Summary iy Displaying 1- 2 / 2
Route Reviewer Approval View Received Last
- OTHER SYSTEMS Mark order % Address To L Type Required only Date updated Status % Comments &
M - 10/02/2020
[ 10 PAULINE GARCIA Individual A Y 00:56:54
— - 10/02/2020
O 2o DARREN BAK Individual A N 10:16:41
ey Displaying1-2/ 2

» Click Release from the Menu Options

Notes:
v' Code under Approval Requested:
A = Approval Required
C = Carbon Copy
v' Codes under View Only:
Y = Yes, Read Only Access
N = No, Full Read/Write Access
v" You can have multiple people listed in the same route order number.

<\

In order for the requisition to be sent to the people listed, you must click Release.

v" You must have the BFNC role in order to release, if you do not, you will create the
routing order and then share it with the BFNC for them to release it to be
approved/submitted.
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Step

Action

31

The Requisition Review & Approval Management screen will then show the
date/time and status of the review.

REQ REVIEW & APPROVAL
MGMT MENU

~ ACTIONS
Add User

Add Team

Edit

Delete
Forward
Release

Recall

~ TOOLS

OPTIONS
Summary

+ OTHER SYSTEMS

Requisition Review & Approval Management

Search Criteria

Route Order: [

Reviewer Type:

Filter on: [

Search

Result Sorted By: Route Order, Reviewer Type

User: ABIGAIL ALABAMA (AGA)
Version: 10.2 Screen ID: RAM

Reset all Search Fields

Import Route List Model

ey Displaying1-2/2
Route Reviewer Approval View Received Last

Mark oOrder % Address To % Type * Required % Only * Date % Updated Status % Comments #
- L 10/02/2020 10/02/2020 Review Pending by PAULINE
] 10 PAULINE GARCIA Individual A 10:26:46 10:26:46 GARCIA
— . 10/02/2020
Ll 20 DARREN BAK Individual A N 10:16:41

ey Displaying 1-2 / 2

» Click Summary from the Menu Options
» Click Home from the Standard Menu Bar

Notes:

v' The recall option may be used if the status is not Reviewed or Approved.
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DEMONSTRATION - APPROVAL & SUBMIT PROCESS

Step

Action

A1

If the person who is on the routing list has set up in their profile to be notified
when things come to their inbox, they will receive an email notification when it's
sent to them. If they do not, you may have to contact them in order to have

them do the approval.

A2

Once logged into C.Request:
» Click Inbox from the Standard Menu Bar

User Inbox Management

USER INBOX MENU

~ ACTIONS Search Criteria
Review and Approve

Review List:
+ OTHER SYSTEMS From: :|

Filter Criteria ~] |

<

User: PAULINE GARCIA (PMG)
Version: 10.2 Screen ID: UL

Reset all Search Fields

Search
Result Sorted By: Last Update Date.
Uy Displaying 1-1/ 1
Mark Document Name ¢ 298t o Reviewer ., ... o fime ¢ priority ¢ APPrOVal y View o\ ¢ Description ¢ Comments
Name Type Required © Only
[ FE="H200022 500005y ARTEATE Individual  10/02/2020 10:26:46 N A ¥ Y Requisition

—  NA-AJ2000-21-00005 ALABAMA

> Click on the Document Name

Displaying1-1/1
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Step

Action

A3

The Requisition Summary screen appears:

User: PAULINE GARCIA (PMG)
Version:

Requisition Summary on: 10.2 Screen ID: RSM

REQUISITION SUMMARY Administration
MENU
purchase For: OCIO/ISMO/ADS/FIN SYS ADMIN ER AJ151200 OCIO/ISMO/ADS/FIN SYS ADMIN R
~ SECTIONS . )
“summary  Delivery Date 10/30/2020
Administration Point of Contact: ABIGAIL ALABAMA
Accounting Purpose: TO PURCHASE COPY/FAX PAPER FOR THE OFFICE
tg‘;ﬂ‘;ems Document Status: Unsubmitted
Notes Procurement Status: Unsubmitted
+ PROPERTIES Account Summary
Sharing
Locking
Number of Codes Assigned to Line Items; 1 Number of Default Codes
PROCUREMENT percent Allocated: 1.00% Total Default Percentage: 0%
Period of Performance Defaults  Total Quantity Allocated 100
Sybroft Documents Total Cost Allocated: $6.59
2 Base Cost Allocated: $6.59
ACTIONS Option Cost Allocated: $0.00
Add to Hotlist Mo Financial Transaction Information.

Manage Reviewers/Approvers
Review and Approve

Line Item
View Status number of Line Items: 1
e Total Cost: $659.00 Base Amount: $659.00 Option Amount: £0.00
SYSTEM OPTIONS Notes
Return To Inbox
No Notes
OTHER SYSTEMS
Project
Review and Approval
Status: Review Pending
Waiting For: PAULINE GARCIA (PMG)
Received At 10/02/2020 10:26:46

The approver would then review all pieces of the requisition. Once they have
reviewed the requisition and are ready to approve:

» Click Review and Approve from the Menu Options

Notes:
v If the view only was done in the routing, the person will only be able to view the
requisition, not be able to make changes.

v If you forgot to make it view only, but the requisition is committed, they will not
be able to make changes.
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Step

Action

A4

The Review Document screen appears.

. User: PAULINE GARCIA (PMG)
Review and Approve Document Version: 10.2 Screen ID: RADF

ROUTING MENU

~ OPTIONS

= = Required Field

Document Number: NA-AJ2000-21-00005

~ OTHER SYSTEMS

Document Name: NA-AJ2000-21-00005
Approve

Disapprove:

Forward Responsibility:

To Reviower )

signature Password: [

@

Comments:

You have characters remaining for your input.

Save | Reset  Cancel

» Check the Approve radio button

» Enter your Signature Password

» Enter any Comments
» Click Save

Notes:
v

v

If as an approving official, you were to disapprove the document, make sure to
enter comments as to why it’s being disapproved.

If as an approving official, you needed to someone else to review/approve, you
would click the radio button Forward Responsibility and enter the code of the
person in the To Review field.

To view the whole routing list, click on View Reviewer List link on the screen.
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Training Exercises

Step Action
A5 The User Inbox Management screen appears and the document is now gone
from their inbox and has been routed to the next person on the list. The
requisitioner will receive an email stating the approval and who'’s it has been
routed to next, if notifications in the profile have been set up.
User Inbox Management erion: 105 Bercen Igal
USER INBOX MENU Document successfully approved.
P;V‘;ﬁl'all‘(\;':iwu\w 4
Reset all Search Fields
+ OTHER SYSTEMS Search Criteria
Review List:
From ]
Route Type:
Filter Criteria | v‘ | v‘ I
Search
Result Sorted By: Last Update Date.
Mark DocumentName ¢ hgent 4 Re}';‘;“:er ¢ Date ¢ Time ¢ Priority & 223;?::.; ‘(')ijl"; 4 New ¢ Description ¢ Comments
No records found that meet the search / filter criteria
S1 In our training exercise, the next person on the routing list is the Funds
Certifying Officer (FCO). Just like the other approver, they will have to log in
and then go to their inbox to open up the requisition.
S2

Once on the Requisition Summary screen and after reviewing all parts of the
requisition, instead of approving they will:

» Click Commit from the Menu Options
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Step

Action

S3

A new window will appear. You will need to verify that everything has passed

all validations.

@ Reguisition Report - Goegle Chrome

Requisition Report

& crequestdtnoaa.eas.commerce.gov/noaa/serviet/DocumentValidations?from=create@&menu=FICT&doc ty.. &

= O X

-

Requisition Administration:

Requisition Line Items:

Financial Interface:

Security Classification:

Review & Approval:

Mandatory Fields:

Alternate CORs:

Government Property:

javascript:closeWin()

Administration section has passed all validations.

Line Items section has passed all validations.

Financial section has passed all validations.

Security Classification section has passed all validations.

Review B Approval section has passed all validations.

Mandatory fields section has passed all validations.

Alternate CORs section has passed all validations.

Government Property section has passed all validations.

[ Close]|

If it did, click Close.

If it didn’t, click Close and then fix any errors and try committing again.

S4

The Financial Interface Validations screen will appear if there were no errors.

Financial Interface Validations

REQUISITION SUMMARY

User: DARREN BAK (DBB)
Version: 10.2 Screen ID: FINVAL

Transaction Information

MENU

S'urr?rﬁary ONS Document Number:
Administration Document Name
Accounting Type: ‘

Line Items Amount:

Forms

Notes

NA-AJ2000-21-00005
NA-AJ2000-21-00005
Commitment
$659.00

Validation Messages

- PROPERTIES
Sharing

Locking

PROCUREMENT
Period of Performance Defaults
Support Documents
History

~ ACTIONS
Submit

Add to Hotlist

> Validate the dollar amount
> Click Save and Post

Save and Post

Cancel
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Step

Action

Notes:

v Please only click the Save and Post link once. Double-clicking will cause
issues within CFS.

S5

The Requisition Summary screen appears. You should now have in the
Account Summary area that a commitment has been sent.

User: DARREN BAK (DBB)

Requisition Summary Version: 10.2 Screen ID: RSM
REQUISITION SUMMARY Administration
MENU
Purchase For: OCIO/1SMO/ADS/FIN SYS ADMIN BR AJ151200 OCIO/ISMO/ADS/FIN SYS ADMIN BR

+ SECTIONS ‘ ,
Summary Delivery Date: 10/30/2020
Administration Point of Contact: ABIGAIL ALABAMA
Accounting Purpose: TO PURCHASE COPY/FAX PAPER FOR THE OFFICE

t‘"e Items Document Status: Unsubmitted

orms

Nates Procurement Status: Unsubmitted

~ PROPERTIES Account Summary
Sharing

Locking ) ‘

Number of Codes Assigned to Line Ttems: 1 Number of Default Codes:

- PROCUREMENT Percent Allocated: 100.00% Total Default Percentage: 0%
Period of Performance Defaults | Total Quantity Allocated: 100
ﬁ“‘zp‘”‘ Documents Total Cost Allocated: $659.00

istor

" Base Cost Allocated: £659.00
- ACTIONS Option Cost Allocated: £0.00

Submit Commitment: Sent to Interface; Awaiting Response Posted: 10/02/2020 12:55:26, for the Amount: $659.00 on Requisition NA-AJ2000-21-00005
Add to Hotlist

Manage Reviewers/Approvers

Review and Approve Line Ttem
C'D"f:"i':““m'- Number of Line Items: 1
Cancel Commit Total Cost: $659.00 Base Amount: $659.00 option Amount: $0.00
View Status
Notes
+ CREATE
No Notes
+ SYSTEM OPTIONS
Return To Inbox .
Project
» OTHER SYSTEMS
C.Award
Review and Approval
Status: Review Pending
Waiting For: DARREN BAK (DBE)
Received At: 10/02/2020 12:40:20

» Click Summary from the Menu Options to refresh the screen

S6

Once you receive the message that the commitment went through do the
following:

Commitment: Accepted/Approved by Financial System Posted: 10/02/2020 12:55:26, for the Amount: $659.00 on Requisition NA-AJ2000-21-00005

» Click Submit from the Menu Options.

Notes:
v' Commitment needs to be done prior to submission.

v' FCO'’s are encouraged to be the ones doing the commitment in case of any
changes needed prior to their approval.

v' The commitment is not actually doing a funds check, it is only verifying that the
ACCS information is a valid and active one in CFS.
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Step

Action

S7

A new window will appear. You will need to verify that everything has passed
all validations.

@ Requisition Report - Google Chrome - (m] X

& crequestdtnoaa.eas.commerce.gov/noaa/serviet/DocumentValidations?from=create8menu=RS&doc_type.. &

Requisition Report

Requisition Administration:
Administration section has passed all validations.

Requisition Line Items:
Line Items section has passed all validations.

Financial Interface:
Financial section has passed all validations.

Security Classification:
Security Classification section has passed all validations.

Review & Approval:
Review & Approval section has passed all validations.

Mandatory Fields:
Mandatory fields section has passed all validations.

Alternate CORs:
Alternate CORs section has passed all validations.

Government Property:
Government Property section has passed all validations.

javascriptcloseWin) ( ]

If it did, click Close.

If it didn’t, click Close and then return back to the requisitioner and have them
fix the issue and re-route.

S8

The Requisition Submit screen appears

P . User: DARREN BAK (DBB)
Requisition Submit Version: 10.2 Screen ID: RS

REQUISITION SUMMARY

MENU [This requisition is currently shared. If you select Save to submit the requisition, the document will be automatically unshared.

~ SECTIONS = = Required Field
Summary
Administration
Accounting
Line Items a
Forms = Assign PR same number as Requisition: (H]
Motes

Requisition Number: NA-AJ2000-21-00005

~ PROPERTIES
Sharing

Locking Purchasing Buyer or Contract Specialist

* acsign To: g
hat ‘PRDCUREHENT Assign to Name:
Period of Performance Defaults

Support Documents

History

0]

y
=

Gave | Reset | Cancel

» Check the Assign PR same number as Requisition checkbox

» Click on the Lookup+ icon for the Purchasing Buyer or Contract
Specialist field
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Step

Action

S9

A new window opens which allows the user to find a buyer or contract
specialist for a particular office. You may need to change the default office and
authority type to send it to the correct mailbox:

€ User LookUp - Google Chrame = O X
@ crequesttrain.eas.commerce.gov/noaa_train/servlet/UserLookUp?screen=RS&lookup=AssignTo [}
Office: NOAA - OCFO (My Office) v Reset all Search Fields

Authority Type: | Contract Specialist *

Filter Criteria: v v

Search Close

L v Displaying1-6 / 6
Agent Code Name Office Title Select
008 CHERYL GRIFFIN NOAA - OCFO @
Q0IH JaeMie Hughes NOAA - OCFO Program Analyst @
152 CHERYL GRIFFIN NOAA - OCFO @
IMN IMMN Train -C MOAA - OCFO @l
TEK TIERRA KIRBY NOAA - OCFO HELP DESK @
TRG TRAINING OFFICE MOAA - OCFO CAWARD MAINBOX TRAINING ID @

-

> Click the Selectl¥ icon of the code you want to choose (i.e. Training
Mailbox)

Notes:
v For training purposes we have our own box to send the requisition.

v’ If you are unable to find the buyer change the Office drop-down selection to
ALL and click Search again.

v' Most Acquisition Offices have a general box where the requisition will appear
in C.Award however, you may be told to send it to a specific person.
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Step Action

S10 | The Requisition Submit screen appears with your selection.

_— ) User: DARREN BAK (DBE)
Requisition Submit Version: 10.2 Screen ID: RS

REQUISITION SUMMARY
MENU TThis requisition is currently shared. If you select Save to submit the requisition, the document will be automatically unshared

~ SECTIONS

= = Required Field
Summary

Administration Requisition Number: NA-AJ2000-21-00005
Accounting
Line Items
Forms = Assign PR same number as Requisition
Notes
+ PROPERTIES
Sharing ) .
Locking Purchasing Buyer or Contract Specialist
* Assign To: -]
~ PROCUREMENT Assign to Name: TRAINING MAILBOX

Period of Performance Defaults
‘Support Documents

History Save | Reset | Cancel

» Click Save

S11 | The Requisition Summary screen appears. At the bottom of the screen in the
Message area you should get a message that the requisition has been
successfully submitted.

Requisition Submitted successfully.

» Click Review and Approve from the Menu Options

S12 | The Review Document screen appears.
» Check the Approve radio button.

» Enter your Signature Password.

» Enter any Comments.

» Click Save.

S13 | The User Inbox Management screen appears and the document is now gone
from their inbox. They can now log out of the system or go to another
requisition to submit and approve.
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INFORMATION FOR REQUISITIONER TO VIEW STATUS

Step

Action

IN1

Home

MAIN MENU
S ICHEEN, | Recently Ac
- CREATE
Reaquisition Results Sorted By: Documen t Type, Document Name, Document Number
ned within the last 90 days

This page displays all documents ope

ZIRIC] Mark All || Unmark All
Document Type

To view the status of the document once it has been submitted, you can either
open the Hot List or Recently Accessed view tabs.

cessed . IEESIES IRGESSIES

Remove from Recently Accessed

User: CRAIG ALASKA (CHA)
Version 10.0 SP2 Screen ID: RAD

Displaying 1-1/ 1
Document Number ¢ Date Last Updated ¢
NAAJ6100-20-00085 11/29/2019

) nAaI6100-20-00085

Displaying 1-1 /1

SYSTEM OPTIONS

OTHER SYSTEMS

» Click the paper icon

54
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Step

Action

IN2

A new window will open showing the status of the document as well as where it
is in the procurement process.

€ Document Information - Google Chrome = O X

AN 94 C 4 ANIa0

@ crequesttrain.eas.commerce.gov/noaa_train/servlet/Documentinformation?docinfo=201911201516300274|201911201516300290[20... &

Document: NAAJS100-20-00085 | NAAJG100-20-00085
Document Information

Document Type : Requisition

Document Name : MNAAJG100-20-00085
Document Number : NAAJS100-20-00085
Document Owner :  CRAIG ALASKA (CHA)

Document Status : Submitted
Procurement Status : Open-Assign

Created On : 11/20/2019 15:16:320
Last Updated On : 11/29/2019 13:56:50

e Procurement not currently shared.
£ pocument not currently locked.

Commitment: Accepted/Approved by Financial System, Posted: 11/29/2019

Financial Information: 5. 0> 45 “posted by: DARREN BAK (DAB), Amount: $658.00

PR Information: Submitted On: 11/29/2019 13:56:50
Purchase Request NAAJSE100-20-00085

MName:

Purchase Request NAAJSE100-20-00085

Mumber:

PR Buyer: TRAINING OFFICE (TRG)
Motes: Motes have not been entered for this procurement.

Related Documents: MNAAJ6100-20-00085, NAAJG100-20-00085 [ PR )

Close

When finished reviewing the information:
» Click Close

IN3

Or from the worksheet tab:

Award/IA

Milestone Acquisition L . Procurement
Plan ] Planning Record Requisition s PR/IA PR ] Award/Micro ] RDD ] Status
Purchase
1 20201002 Ex 3 10/30/2020 ynsybmitted 1
MNA-AJ2000-21-00007
11 ma-a17000-21-00005 1 na-a12000-21-00005 10/30/2020 Open-Assign

NA-AJ2000-21-00005 NA-AJ2000-21-00005

Click the paper icon for the Purchase Request, rather than requisition to view the
status
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Step Action

IN4 | A new window will open showing the status:

@ Document Information - Google Chrome:

& crequestdinoaa.eas.commerce.gov/noaa/servlet/Documentinformaticn?docinfo=202010050827400743]2020100206

Document: NA-AJ2000-21-00005 | NA-AJ2000-21-00005
Document Information

Document Type : Purchase Request
Document Name : MA-AJ2000-21-00005
Document Number : MA-AJ2000-21-00005
Document Qwner : TRAINING MAILBOX (TRN)
Document Status : Qpen-Assign

Procurement Status : Qpen-Assign

Created On : 10/05/2020 08:27:40
Last Updated On : 10/05/2020 08:27:40

e Procurement net currently shared.
B Dpocument not currently locked.

Notes: MNotes have not been entered for this procurement.
Related Documents: NA-AJ2000-21-00005, NA-AJ2000-21-00005 ( Requisition )
Close

INS | Or if it has been assigned to a specific acquisition staff member:

& Document Information - Google Chrome = O X

# crequesttrain.eas.commerce.gov/noaa_train/servlet/Documentinformation?docinfo=201911291356500875[2019112015... @

Document: NAAJE100-20-00085 | NAAJG100-20-00085
Document Information

Document Type : Purchase Request
Document Name : MAAJG100-20-00085
Document Number : MAAJE100-20-00085
Document Owner : ERIN K COBBS (EKC)
Document Status : Open-Assign
Procurement Status : Open-Assign

Created On : 11/29/2019 12:56:50
Last Updated On : 11/29/2019 123:56:50

15 Procurement not currently shared.
5] Document not currently locked.

Motes: Motes have not been entered for this procurement.
Related Documents: MNAAJ6100-20-00085, MAAJ6100-20-00085 ( Requisition )
Close
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Exercise #4: Create a Requisition (Printer)

Objectives: ¢ Navigate through C.Request
e Create a Requisition
e Follow flow chart

Instructions:  Execute the following steps:

Your office is in need of a Laser Jet Printer. You go to GSA Advantage and find the
following: HP COLOR LASER JET CP4025N PRINTER under contract (GS-35F-
0103N) for $1,366.17.

Step Action

1 From the Home screen:

» Click Create Requisition from the Menu Options

The Requisition PIIN and Name screen appears:

» Choose Document Number from the PICKLIST

» Change the Document Name if you wish (i.e. [date] PRINTER)
» Click Save

3a
tab

Enter the Delivery Date (i.e. MM/DD/YYYY)

Enter the COR (i.e. EKC — make sure to use the refresh icon if typing)
Choose the FCOT (i.e. 5 zeros)

Look up the UNSPSC code and select it (i.e. OFFICE MACHINE)

Enter the Purpose (i.e. TO PROCURE A COLOR LASER JET PRINTER
FOR THE OFFICE)

Enter the Contract Number (i.e. GS-35F-0103N)
Click on the Funding view tab

YV V. V V V

YV VY
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Step

Action

3b

From the Funding view tab:

>

>
>
>
>

Enter the Certifies bonafide need field (i.e. TRAINING ID name)
Enter the Certifies funds available field (i.e. DAB)

Select the Agency Identifier (i.e. 13)

Select the Main Account (i.e. 1450)

Click on the Addresses view tab

From the Addresses view tab:

>

>

Enter or verify all applicable addresses including Supplemental Address
Information

Click Save

The Requisition Summary screen appears:

>
>

Click Add to Hotlist from the Menu Options
Click Line Items from the Menu Options

The Requisition Line Item Management screen appears:

>

Click Create CLIN from the Menu Options
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Step

Action

7

The Requisition Line Item Detail screen appears:

From the Administration view tab (Line 0001):

>
>
>
>

>
>

Enter the Qty (i.e. 1)
Enter the Ul (i.e. EA)
Enter the Cost (i.e. 1366.17)

Enter the Description (i.e. HP COLOR LASER JET CP4025N PRINTER
FED-GSA CONTRACT GS-35F-0103N)

Enter the Receiving Office Number (i.e. copy an Address Code)
Click on the Address view tab

From the Address view tab:

>
>
>

Verify addresses are correct
Click Apply
Click Accounting from the Menu Options

The Account Code Management screen appears:

>

Click Create from the Menu Options

The Account Code Detail screen appears:

>

Click the “Import Entire Account Code” link

9b

A new window will open. The default will be Account Table. Click on the drop-
down Search Criteria field and select Personal Account Codes. Click Search.
All Account Codes entered on your Profile appear here.

>

Click the Select¥ icon for the code you want to select

9¢c

The fields then will populate with the values from the account code selected.

>

>
>
>
>

Change Object Class to 31282535
Select Allocation By (i.e. Cost)
Enter Cost (i.e.1366.17)

Enter Quantity (i.e.1)

Click Save
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Step Action

10 The Account Code Management screen appears with the accounting now
listed.
» Click Summary from the Menu Options

» Click Forms from the Menu Options

11 The Requisition Form Setup screen appears:

» Click the Accounting Codes checkbox

» Click the Cost of Line Item Applied to the Account Code checkbox
» Click the Delivery Date checkbox

» Click View Form

A warning message will appear.

» Click OK

12 A new window opens showing your requisition form in Adobe (pdf) format. You

can then print or save your document.
» Close out the window.

> Click Save

13 The Requisition Summary screen appears. For training purposes, you're

done. In production you would still finish all the steps.
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Exercise #5: Create a Requisition (Helium — 2 ACCS codes)

Objectives:

¢ Navigate through C.Request
e Create a Requisition
e Understand adding more than one accounting code

e Follow flow chart

Instructions:  Execute the following steps:

You are purchasing for your office some Liquid Helium that should last the office for 3
months. You'll need 18,200 liters at $5.49 per liter.

Step

Action

From the Home screen:

>

Click Create Requisition from the Menu Options

The Requisition PIIN and Name screen appears:

>
>
>

Choose Document Number from the PICKLIST
Change the Document Name if you wish (i.e. [date] HELIUM)
Click Save

3a

The Requisition Administration screen appears. From the Administration view
tab:

>

>
>
>
>

YV VY

Enter the Delivery Date (i.e. MM/DD/YYYY)

Enter the COR (i.e. EKC — make sure to use the refresh icon if typing)
Choose the FCOT # (i.e. 5 zeros)

Look up the UNSPSC code and select it (i.e. HELIUM)

Enter the Purpose (i.e. TO PURCHASE 18,200 LITERS OF LIQUID HELIUM
AT $5.49 PER LITER FOR 3 MONTHS)

Enter the Vendor (i.e. MOTE MARINE LABORATORY, INC)
Click on the Funding view tab
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Step Action

3b | From the Funding tab:

» Enter the Certifies bonafide need field (i.e. TRAINING ID name)
» Enter the Certifies funds available field (i.e. DAB)

» Enter the Agency Identifier (i.e. 13)

» Enter the Main Account (i.e. 1450)

» Click on the Addresses tab

4 From the Addresses tab:

» Enter or verify all applicable addresses including Supplemental Address
Information

» Click Save

5 The Requisition Summary screen appears:
» Click Add to Hotlist from the Menu Options
» Click Line Items from the Menu Options

6 The Requisition Line Item Management screen appears:
» Click Create CLIN from the Menu Options
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Step

Action

7

The Requisition Line Item Detail screen appears:
From the Administration view tab (Line 0001):
Enter the Qty (i.e. 18200)

Enter the Ul (i.e. LITER)

Enter the Cost (i.e. 5.49)

Enter the Description (i.e. LIQUID HELIUM)
Enter the Receiving Office Number (i.e. copy an Address Code)
Click on the Address tab

From the Address tab:

» Verify addresses are correct

» Click Apply

» Click Accounting from the Menu Options

YV V V V V V

The Account Code Management screen appears:
» Click Create from the Menu Options

The Account Code Detail screen appears:

Import your Personal Account Code (i.e. 28LEF28)
Change the Object Class to: 26142535

Select Allocation By (i.e. Cost)

Enter Cost (i..49959)

Enter Quantity (i.e. 9100)

YV VYV V V V V

Click Save

10

The Account Code Management screen appears with the accounting now
listed.

» Click Create from the Menu Options
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Step

Action

11

The Account Code Detail screen appears:

Import your Personal Account Code (i.e. 28LEF29)
Change the Object Class to: 26142535

Select Allocation By (i.e. Cost)

Enter Cost (i..49959)

Enter Quantity (i.e. 9100)

YV VYV V V V V

Click Save

12

The Account Code Management screen appears with the accounting now
listed.

» Click Summary from the Menu Options
» Click Forms from the Menu Options

13

The Requisition Form Setup screen appears:

» Click the Accounting Codes checkbox

» Click the Cost of Line Item Applied to the Account Code checkbox
» Click the Delivery Date checkbox

» Click View Form

A warning message will appear:

» Click OK

14

A new window will open showing your requisition form in Adobe (pdf) format.
Print or save your document.

»> Close the window
» Click Save

15

The Requisition Summary screen appears. For training purposes, you're
done. In production you would still finish all the steps.
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Exercise #6: Create a Requisition (Chairs and Rounding Issue)

Objectives: ¢ Navigate through C.Request
e Create Multiple Accountings for a line
e Understand
¢ Use Rounding Worksheet to figure out multiple accounting costs

e Follow flow chart

Instructions:  Execute the following steps:

Your boss has emailed you with the details of the ergonomic chairs needed to be
ordered for the office staff. Please use the details in the email to set up your requisition.

Subject: Chair Order

From: Your Boss <yourboss@noaa.gov>
Date: Mon, Current Date 08:10:20 — 0500
To: You <yourname@noaa.gov>

We need 30 new ergonomic chairs. Below are the specs. Use GSA # GS-27F-0024V and the
following accounting codes for these purchases.

(30) BIG AND TALL MESH CHAIR WITH MESH SEAT

Brand: Office Star Space Collection

Dimensions: 27"W x 26-1/2"D x 42"H

GS-27F-0024V $393.82/ea
ACCS:
14-21-28LEF28-B00-0001-022116001-3021000200000000-26182535-000000 $5000.25
14-21-28LEF29-P00-0001-022116001-3031000200000000-26182517-000000 $1500.10
14-21-28LEF30-P00-0001-022145030-3021000200000000-26182535-000000 $2500.15
14-21-28LEF32-P00-0001-022144002-3031000200000000-26182517-000000 $2814.10
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Step

Action

From the Home screen:
» Click Create Requisition from the Menu Options

The Requisition PIIN and Name screen appears:

» Choose Document Number from the PICKLIST

» Change the Document Name if you wish (i.e. [date] CHAIRS)
» Click Save

3a

The Requisition Administration screen appears. From the Administration view
tab

» Enter the Delivery Date (i.e. MM/DD/YYYY)

» Enter the COR (i.e. EKC — make sure to use the refresh icon if typing)
» Choose the FCOT # (i.e. 5 zeros)

» Look up the UNSPSC code and select it (i.e. CHAIRS)

>

Enter the Purpose (i.e. PURCHASE OF ERGONOMIC CHAIRS FOR THE
OFFICE)

Enter the Contract Number (i.e. GS-27F-0024V)
Click on the Funding view tab

YV VY

3b

From the Funding view tab:

» Enter the Certifies bonafide need field (i.e. TRAINING ID name)
> Enter the Certifies funds available field (i.e. DAB)

» Enter the Agency Identifier (i.e. 13)

» Enter the Main Account (i.e. 1450)

» Click on Addresses tab

From the Addresses view tab:

» Enter or verify all applicable addresses including Supplemental Address
Information

» Click Save
» Click Add to Hotlist from the Menu Options
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Step Action
5 The Requisition Summary screen appears:
» Click Line Items from the Menu Options.
6 The Requisition Line Item Management screen appears:
» Click Create CLIN from the Menu Options.
6a | From the Administration view tab (Line 0001):

> Enter the Qty (i.e. 30)

> Enter the Ul (i.e. EA)

» Enter the Cost (i.e. 393.82)
>

Enter a Description (i.e. BIG AND TALL MESH CHAIR WITH MESH SEAT
OFFICE STAR SPACE COLLECTION BRAND DIMENSIONS 27 INW X
26.5IND X 42 IN H, GSA CONTRACT GS-27F-0024V)

» Enter the Receiving Office Number (i.e. copy an Address Code)
» Click on the Address tab

From the Address tab:

» Verify the addresses are correct

» Click Apply

» Click Accounting from the Menu Options

Notes:
v' You need to Apply here in order to save the line information and provide the ability
to add line accounting.

v’ If you select save instead of apply, you will need to re-open the line in order to see
the Accounting option for the line.
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Step Action
6b | The Account Code Management screen appears.
Requisition Line Item Account Code Management \zer: ABIGAIL ALABAMA (a08)
ACCOUNT CODE MENU
Line Item No.: 0001, BIG AND TALL MESH CHAIR WITH MESH SEAT OFFICE STAR SPACE COLLECTION BRAND DIMENSIONS 27 IN W X
~ ACTIONS 26.5 ...
Create
Edit
Delete Search Criteria Reset all Search Fields
Search Criteria [ ~] | v ]
» SYSTEM OPTIONS
Slummarv
Line Items Search
~ OTHER SYSTEMS
Line Item Total: 11814.60 Total Cost: $0.00 Total Percent: 0% Total Quantity: 0.00
Result Sorted By: Account Code
Mark All || Unmark All
KR Displaying0-0 /0
Mark Account Code ® Cost s Quantity # Percent s BOC +
Mo Account Code records found that meet the filter criteria
b v Displaying0-0/0
6b1 | Because there are more than three accounting codes that will need to added to

this line and because your boss has asked that it be done by cost, you may end
up with what is called a rounding issue. This happens because C.Request only
allows for two decimal points in the quantity but CFS requires four. However,
CFS does not allow for a 0 quantity. So if the quantity broken out equals
something along the lines of 0.0040 it will round to zero, but you must enter at
least 0.01 in C.Request in order for it to go through in CFS.

So when you add accounting to the line the following must be there:
» Line Item Total = Total Cost (accounting)
» Total Percentage = 100%
» Total Quantity (accounting) = Quantity on Line

To make this easier to calculate and easier to enter into C.Request, we have
come up with a worksheet that will help.

FY 2021 — Version 1.0 68




C.Request for New Users

Training Exercises

Step

Action

6b2

The Rounding Worksheet is done in Excel.

Summary Line Total Difference Fix
Line ltem Total 200,000.00  200,000.00 0.00
Total Quantity I 3U.DD.I 30.01 -0.01 0.00
Quantity can not be 0 in CFS and Crequest only shows 2 decimal places

ACCS Cost Quantity Rounded Qty Fix Percent
#1 500.00 0.0750| 0.08 0.25%
#2 50.00 0.0090| 0.01 0.03%
#3 100,000.00 15.0000 15.00 50.00%,
#4 75,000.00 11.2500 11.25 37.50%,
#5 24,450.00 3.6690 3.67 12.23%,|
#6 0.0000| 0.00 0.00%
#7 0.0000| 0.00 0.00%
#8 0.0000| 0.00 0.00%
#9 0.0000| 0.00 0.00%
#10 0.0000| 0.00 0.00%
#11 0.0000| 0.00 0.00%
#12 0.0000| 0.00 0.00%
#13 0.0000| 0.00 0.00%
#14 0.0000| 0.00 0.00%
#15 0.0000| 0.00 0.00%
#16 0.0000| 0.00 0.00%
#17 0.0000| 0.00 0.00%
#18 0.0000| 0.00 0.00%
#19 0.0000| 0.00 0.00%
#20 0.0000| 0.00 0.00%
#21 0.0000| 0.00 0.00%
#22 0.0000| 0.00 0.00%
#23 0.0000| 0.00 0.00%
#24 0.0000| 0.00 0.00%
#25 0.0000| 0.00 0.00%
#26 0.0000| 0.00 0.00%
#27 0.0000| 0.00 0.00%
#28 0.0000| 0.00 0.00%
#29 0.0000| 0.00 0.00%

The colored boxes do all of the calculations for you. Notice there are two
columns for quantity. The first is for the CFS side showing the four positions
after the decimal point. The second column shows what C.Request does to
‘round” the quantity to two positions after the decimal point. If any value in the
Rounded Qty column has rounded to 0.00 or the subtotal of that column is more
than the line quantity, you will need to use the FIX column to fix the quantities to
make sure they equal the line quantity. Any column that is white is a fillable field

and will allow you to enter data.
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Step Action
6b21 | For this exercise there are 4 accounting codes to add. Enter these accounting
codes into the worksheet first:
Summary Line Total Difference Fix
Line ltem Total 11,814.60 11,814.60 0.00
Total Quantity 30.00 30.01 -0.01 0.00
Quantity can not be 0 in CFS and Crequest only shows 2 decimal places
ACCS Cost Quantity Rounded Qty Fix Percent
#1 5,000.25 12.6960 12.70 A2.32%
#2 1,500.10 3.8100 3.81 12.70%
#3 2,500.15 6.3480 6.35 21.16%
#4 2,814.10 7.1460 7.15 23.82%
The worksheet automatically calculates the quantity and percentage to be added
to C.Request. In the subtotal and total areas, you will see if there are any
differences that need to be corrected.
Any changes to the quantity should be done in the FIX column and if that is the
case, you will need to make sure to enter that column’s quantity into C.Request.
Once you are finished, print this worksheet for easy entry into C.Request.
6¢c | Return to C.Request from the Account Code Management screen:

» Click Create from the Menu Options.
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Step

Action

6¢c1

The Account Code Detail screen appears.

i User: ABIGAIL ALABAMA (AGA)
Account Code Detall Version: 10.2 Screen ID: RACD

ACCOUNT CODE DETAIL

MENU

~ SYSTEM OPTIONS Bureau Code (2):

Accoun ting

Line Item No.: 0001, BIG AND TALL MESH CHATR WITH MESH SEAT OFFICE STAR SPACE COLLECTION BRAND DIMENSIONS 27 IN W X 26.5 ...

'[l_ﬂpor‘t Entire Account Code

10

Fiscal Year (2):

~+ OTHER SYSTEMS Project (7):

<

YV V VYV V

Task (3):
Fund (4):

Program (9):

]
1
[

1
I
organization (16): [ ]
Object Class (8): —

I

User Defined (6):

Allocation By:

Save Apply Reset Cancel

Enter all values of the first ACCS (e.g., bureau, fund, etc.) from your
worksheet

14-21-28LEF28-B00-0001-022116001-3021000200000000-26252535-
000000

Select Allocation By (i.e. Cost)
Enter the Cost (i.e. 5000.25)
Enter the Quantity (i.e. 12.69)
Click Save

6c2

A\

\ Vv

YV V VYV V

Click Create from the Menu Options.
Enter all values of the ACCS (e.g., bureau, fund, etc.).

14-21-28LEF29-P00-0001-022116001-3031000200000000-26252535-
000000

Select Allocation By (i.e. Cost)
Enter the Cost (i.e. 1500.10)
Enter the Quantity (i.e. 3.81)
Click Save
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Step

Action

6c3

» Click Create from the Menu Options.

\ Vv

YV V VvV X

Enter all values of the ACCS (e.g., bureau, fund, etc.).

14-21-28LEF30-P00-0001-022145030-3021000200000000-26182535-
000000

Select Allocation By (i.e. Cost)
Enter the Cost (i.e. 2500.15)
Enter the Quantity (i.e. 6.35)
Click Save

6c4

Y

\ Vv

YV V VvV X

Click Create from the Menu Options.
Enter all values of the ACCS (e.g., bureau, fund, etc.).

14-21-28LEF32-P00-0001-022144002-3031000200000000-26182535-
000000

Select Allocation By (i.e. Cost)
Enter the Cost (i.e. 2814.10)
Enter the Quantity (i.e. 7.15)
Click Save
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Step

Action

6d

> Verify the Line Item Total equals Total Cost

» Verify the Total Percentage equals 100%

» Verify the Total Quantity equal the total line item quantity

ACCOUNT CODE MENU

~ ACTIONS
Create

Edit

Delete

SYSTEM OPTIONS
Summary
Line Items

OTHER SYSTEMS

PR . User: ABIGAIL ALABAMA (AGA)
Requisition Line Item Account Code Management Version: 10.2  Screen 1D RAC

Account Code successfully updated.

4
Line Ttem No.: 0001, BIG AND TALL MESH CHAIR WITH MESH SEAT OFFICE STAR SPACE COLLECTION BRAND DIMENSIONS 27 IN W X
26.5 ...
Search Criteria Reset all Search Fields
Search Criteria ~] | ~| |
Search
Line Item Total:  11814.60 Total Cost: $11,814.60 Total Percent:  100% Total Quantity: 30.00
Result Sorted By: Account Code
Mark Al Unmark All
e Displaying 1 -4 / 4
Mark Account Code $ Cost ¢ Quantity # Percent # BOC +
[J 1421281 EF?8B00000102211600130210002000000002 000000  $5,000.25 12.69 42.32
() 1421281 EF?9PD00001022116001303100020000000026252535000000  $1,500.10 3.81 12.7
[ 142128LEF20P000001022145030302100020000000026252535000000  $2,500.15 6.35 21.16
[ 1421281 EF32PD00001022144002303100020000000026252535000000  $2,814.10 7.15 23.82
Displaying 1 -4/ 4

» If you are finished, click Summary from the Menu Options

» Click Forms from the Menu Options

The Requisition Form Setup screen appears:

» Click the Accounting Codes checkbox

» Click the Cost of Line Item Applied to the Account Code checkbox
» Click the Delivery Date checkbox

» Click View Form

A warning message will appear:

» Click OK

A new window opens showing your requisition form in Adobe (pdf) format
or save your document.

» Close the window
> Click Save

. Print
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Step Action

10 | The Requisition Summary screen appears. For training purposes, you're
done. In production you would still finish all the steps.
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Exercise #7: Create a Requisition (SEACAT - Multiple Lines)

Objectives: e Navigate through C.Request
e Create Multiple Lines
e Follow flow chart

Instructions:  Execute the following steps:

You will need to create a requisition that has multiple lines per a quote about a SEACAT
profiler that needs to be confirmed and recertified.

Step Action

1 From the Home screen:

» Click Create Requisition from the Menu Options

2 The Requisition PIIN and Name screen appears:
» Choose Document Number from the PICKLIST
» Change the Document Name if you wish (i.e. [date] SEACAT)
» Click Save

3a

The Requisition Administration screen appears. From the Administration view
tab

» Enter the Delivery Date (i.e. MM/DD/YYYY)

» Enter the COR (i.e. EKC — make sure to use the refresh icon if typing)

» Choose the FCOT # (i.e. 5 zeros)

» Look up the UNSPSC code and select it (i.e. EQUIPMENT INSPECTION)

» Enter the Purpose (i.e. CONFIRM AND RECERTIFY SBE 19 CALIBRATE
CONDUCTIVITY TEMPERATURE AND PRESSURE NOAA SHIP)

» Enter the Vendor (i.e. SEABIRD)

» Click on the Funding view tab
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Step

Action

3b

From the Funding view tab:

>

>
>
>
>

Enter the Certifies bonafide need field (i.e. TRAINING ID name)
Enter the Certifies funds available field (i.e. DAB)

Select the Agency Identifier (i.e. 13)

Select the Main Account (i.e. 1450)

Click on the Addresses view tab

From the Addresses view tab:

>

>

Enter or verify all applicable addresses including Supplemental Address
Information

Click Save

The Requisition Summary screen appears:

>
>

Click Add to Hotlist from the Menu Options
Click Line Items from the Menu Options

The Requisition Line Item Management screen appears:

>

Click Create CLIN from the Menu Options
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Step Action

/ The Requisition Line Item Detail screen appears:
From the Administration view tab (Line 0001):
» Enter the Qty (i.e. 5)
> Enter the Ul (i.e. EA)
» Enter the Cost (i.e. 170)
» Enter the Description (i.e. CONFIRM/RECERTIFY SBE28)
» Enter the Receiving Office Number (i.e. copy an Address Code)
» Click on the Address view tab
From the Address view tab:
» Verify addresses are correct
» Click Apply
» Click Accounting from the Menu Options

8

The Account Code Management screen appears:

VV YV V V VVVY

Click Create from the Menu Options

Click the “Import Entire Account Code” link
Select a Personal Account Code

Change Object Class to 25272535

Select Allocation By (i.e. Cost)
Enter Cost (i..850.00)
Enter Quantity (i.e.5)

Click Save
Click Create CLIN from the Menu Options
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Step Action

9 The Requisition Line Item Detail screen appears:
From the Administration view tab (Line 0002):
» Enter the Qty (i.e. 5)
> Enter the Ul (i.e. EA)
» Enter the Cost (i.e. 495)
» Enter the Description (i.e. CALIBRATE CONDUCTIVITY/PRESSURE)
» Enter the Receiving Office Number (i.e. copy an Address Code)
» Click on the Address view tab
From the Address view tab:
» Verify addresses are correct
» Click Apply
» Click Accounting from the Menu Options

10

The Account Code Management screen appears:

VV YV V V VVVY

Click Create from the Menu Options

Click the “Import Entire Account Code” link
Select a Personal Account Code

Change Object Class to 25272535

Select Allocation By (i.e. Cost)
Enter Cost (i.e.2475.00)
Enter Quantity (i.e.5)

Click Save
Click Create CLIN from the Menu Options
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Step Action

11 The Requisition Line Item Detail screen appears:

From the Administration view tab (Line 0003):
» Enter the Qty (i.e. 1)

» Enter the Ul (i.e. LO)

» Enter the Cost (i.e. 4410)

>

Enter the Description (i.e. CONFIRM/RECERTIFY SBE EQUIP PER
QUOTE)

» Enter the Receiving Office Number (i.e. copy an Address Code)
» Click on the Address view tab

From the Address view tab:

» Verify addresses are correct

> Click Apply

» Click Accounting from the Menu Options

12 The Account Code Management screen appears:

Click Create from the Menu Options

Click the “Import Entire Account Code” link
Select a Personal Account Code

Change Object Class to 25272535

Select Allocation By (i.e. Cost)
Enter Cost (i..4410.00)
Enter Quantity (i.e.1)

Click Save
Click Create CLIN from the Menu Options

YV V V V VVVY
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Step Action

13 The Requisition Line Item Detail screen appears:

From the Administration view tab (Line 0004):
> Enter the Qty (i.e. 1)

» Enter the Ul (i.e. LO)

» Enter the Cost (i.e. 5275)

>

Enter the Description (i.e. CONFIRM/RECERTIFY SBE EQUIP PER
QUOTE)

» Enter the Receiving Office Number (i.e. copy an Address Code)
» Click on the Address view tab

From the Address view tab:

» Verify addresses are correct

> Click Apply

» Click Accounting from the Menu Options

14 The Account Code Management screen appears:

Click Create from the Menu Options

Click the “Import Entire Account Code” link
Select a Personal Account Code

Change Object Class to 25272535

Select Allocation By (i.e. Cost)
Enter Cost (i.e.5275.00)
Enter Quantity (i.e.1)

Click Save
Click Create CLIN from the Menu Options

YV V V V VVVY
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Step Action

15 The Requisition Line Item Detail screen appears:

From the Administration view tab (Line 0005):
» Enter the Qty (i.e. 1)

» Enter the Ul (i.e. JB)

» Enter the Cost (i.e. 5485)

>

Enter the Description (i.e. CONFIRM/RECERTIFY SBE EQUIP PER
QUOTE)

» Enter the Receiving Office Number (i.e. copy an Address Code)
» Click on the Address view tab

From the Address view tab:

» Verify addresses are correct

» Click Apply

» Click Accounting from the Menu Options

16 The Account Code Management screen appears:

Click Create from the Menu Options

Click the “Import Entire Account Code” link
Select a Personal Account Code

Change Object Class to 25272535

Select Allocation By (i.e. Cost)
Enter Cost (i..5485.00)
Enter Quantity (i.e.1)

Click Save
Click Create CLIN from the Menu Options

YV V V V VVVY
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Step Action

17 The Requisition Line Item Detail screen appears:

From the Administration view tab (Line 0006):
> Enter the Qty (i.e. 1)

» Enter the Ul (i.e. JB)

» Enter the Cost (i.e. 793)

>

Enter the Description (i.e. CONFIRM/RECERTIFY 11/11PLUS; PERFORM
MINOR REPAIRS - SEE QUOTE)

» Enter the Receiving Office Number (i.e. copy an Address Code)
» Click on the Address view tab

From the Address view tab:

» Verify addresses are correct

» Click Apply

» Click Accounting from the Menu Options

18 The Account Code Management screen appears:

Click Create from the Menu Options

Click the “Import Entire Account Code” link
Select a Personal Account Code

Change Object Class to 25272535

Select Allocation By (i.e. Cost)
Enter Cost (i.e.793.00)
Enter Quantity (i.e.1)

Click Save
Click Summary from the Menu Options

V VV V V V VVVY

Click Forms from the Menu Options
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Step

Action

19

The Requisition Form Setup screen appears:

» Click the Accounting Codes checkbox

» Click the Cost of Line Item Applied to the Account Code checkbox
» Click the Delivery Date checkbox

» Click View Form

A warning message will appear.

» Click OK

20

A new window opens showing your requisition form in Adobe (pdf) format. You
can then print or save your document.

» Close out the window.
> Click Save

21

The Requisition Summary screen appears. For training purposes, you're
done. In production you would still finish all the steps.
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Exercise #8: Create a Requisition (Cell Phone - Multiple Lines)

Objectives: e Navigate through C.Request
e Create Multiple Lines
e Follow flow chart

Instructions:  Execute the following steps:

You will need to create a requisition that has multiple lines per a quote about a cell
phone service.

Step Action

1 From the Home screen:

» Click Create Requisition from the Menu Options

2 The Requisition PIIN and Name screen appears:
» Choose Document Number from the PICKLIST
» Change the Document Name if you wish (i.e. [date] CELLPHONE)
» Click Save

3a

tab

» Enter the Delivery Date (i.e. MM/DD/YYYY)

» Enter the COR (i.e. EKC — make sure to use the refresh icon if typing)
» Choose the FCOT # (i.e. 5 zeros)

» Look up the UNSPSC code and select it (i.e. PHONE)

>

Enter the Purpose (i.e. TO PROCURE CELL PHONE SERVICE FOR
EMPLOYEE JOE SMITH)

Enter the Vendor (i.e. SPRINT)
Click on the Funding view tab

YV VY
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Step

Action

3b

From the Funding view tab:

>

>
>
>
>

Enter the Certifies bonafide need field (i.e. TRAINING ID name)
Enter the Certifies funds available field (i.e. DAB)

Select the Agency Identifier (i.e. 13)

Select the Main Account (i.e. 1450)

Click on the Addresses view tab

From the Addresses view tab:

>

>

Enter or verify all applicable addresses including Supplemental Address
Information

Click Save

The Requisition Summary screen appears:

>
>

Click Add to Hotlist from the Menu Options
Click Line Items from the Menu Options

The Requisition Line Item Management screen appears:

>

Click Create CLIN from the Menu Options
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Step

Action

7

The Requisition Line Item Detail screen appears:

From the Administration view tab (Line 0001):

>
>
>
>

>
>

Enter the Qty (i.e. 1)
Enter the Ul (i.e. EA)
Enter the Cost (i.e. 720)

Enter the Description (i.e. CELL PHONE SERVICE $60/MO FOR YEAR
STARTING ON DATES LISTED IN SOW)

Enter the Receiving Office Number (i.e. copy an Address Code)
Click on the Address view tab

From the Address view tab:

» Verify addresses are correct

>
>

Click Apply
Click Accounting from the Menu Options

The Account Code Management screen appears:

YV YV V V VVVY

Click Create from the Menu Options

Click the “Import Entire Account Code” link
Select a Personal Account Code

Change Object Class to 23382535

Select Allocation By (i.e. Cost)
Enter Cost (i.e.720.00)
Enter Quantity (i.e.1)

Click Save
Click Create CLIN from the Menu Options
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Step Action

9 The Requisition Line Item Detail screen appears:
From the Administration view tab (Line 0002):
> Enter the Qty (i.e. 1)
> Enter the Ul (i.e. EA)
» Enter the Cost (i.e. 200)
» Enter the Description (i.e. OVERAGE COSTS)
» Enter the Receiving Office Number (i.e. copy an Address Code)
» Click on the Address view tab
From the Address view tab:
» Verify addresses are correct
» Click Apply
» Click Accounting from the Menu Options

10

The Account Code Management screen appears:

YV VV V V V VVVYVY

Click Create from the Menu Options

Click the “Import Entire Account Code” link
Select a Personal Account Code

Change Object Class to 23382535

Select Allocation By (i.e. Cost)
Enter Cost (i.e.200.00)
Enter Quantity (i.e.1)

Click Save
Click Summary from the Menu Options

Click Forms from the Menu Options
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Step

Action

11

The Requisition Form Setup screen appears:

» Click the Accounting Codes checkbox

» Click the Cost of Line Item Applied to the Account Code checkbox
» Click the Delivery Date checkbox

» Click View Form

A warning message will appear.

» Click OK

12

A new window opens showing your requisition form in Adobe (pdf) format. You
can then print or save your document.

» Close out the window.
> Click Save

13

The Requisition Summary screen appears. For training purposes, you're
done. In production you would still finish all the steps.
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Exercise #9: Create a Requisition — Simple Contract with Option
Period

Objectives: ¢ Navigate through C.Request
e Create a Requisition for a Simple Contract with option period
e Use the Option View Tab

e Follow flow chart

Instructions:  Execute the following steps:

Your office needs janitorial services for various locations. You'll need to create a
requisition for the first year and add an option year.

Step Action

1 From the Home screen:

» Click Create Requisition from the Menu Options

2 The Requisition PIIN and Name screen appears:
» Choose Document Number from the PICKLIST
» Change the Document Name if you wish (i.e. [date] JANITOR SVCS)
» Click Save

3a

The Requisition Administration screen appears. From the Administration view
tab

» Enter the Delivery Date (i.e. MM/DD/YYYY)

Enter the COR (i.e. EKC — make sure to use the refresh icon if typing)
Choose the FCOT # (i.e. JANITOR/CLEANING)

Look up the UNSPSC code and select it (i.e. JANITOR)

Enter the Purpose (i.e. TO PROCURE JANITOR SERVICES)

Click on the Funding view tab

YV V V VYV V
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Step

Action

3b

From the Funding view tab:

» Enter the Certifies bonafide need field (i.e. TRAINING ID name)
> Enter the Certifies funds available field (i.e. DAB)

» Select the Agency Identifier (i.e. 13)

» Select the Main Account (i.e. 1450)

» Click on the Addresses view tab

From the Addresses view tab:

» Enter or verify all applicable addresses including Supplemental Address
Information

» Click Save

The Requisition Summary screen appears:
» Click Add to Hotlist from the Menu Options
» Click Period of Performance Defaults from the Menu Options

The Period of Performance Defaults Management screen appears:

: User: ABIGAIL ALABAMA (AGA)
Period of Performance Defaults Management Version: 102 Sereen 1D+ PORD
PERIOD OF PERFORMANCE .
DEFAULTS MENU Search Criteria Reset all Search Fields
- ACTIONS
Create Filter on: [ ~] v
Delete
Search
v SYSTEM OPTIONS Result Sorted By: Default Begin Date Ascending

Summary
Line Items

Mark All | Unmark All
« OTHER SYSTEMS

I Displaying1-2 /2
Default Default Total
Mark Period ¢ Begin ¢ End ¢ ¢  calendar/Work Days ¢ Assigned .
Days
Date Date
[[] Base Period Calendar No
[ option Period Calendar No
e Displaying1-2 /2

» Click Base Period (Use the system generated one)

Notes:

v The system generated Base Period is the only one that the system recognizes as an
actual base period.

v Anything else created the system will only recognize as an option period.
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Step

Action

7

PERIOD OF PERFORMANCE
DEFAULTS MENU

~ ACTIONS

SYSTEM OPTIONS
Summary
Line Items

OTHER SYSTEMS

Choose Use

YV V. V V V

Click Save

Period of Performance Default Detail

“Period: Base Period
Use @® calendar O work Days
Calculate By: @ pates O No. of Days

Default Begin

—

Date:

Default End l:rﬁ
Date:

No. of Days:

Assigned: No

Save Reset

(i.e. Calendar)

Choose Calculate By (i.e. Dates)
Enter the Default Begin Date
Enter the Default End Date

Cancel

The Period of Performance Default Detail screen appears:

User: ABIGAIL ALABAMA [AGA)
Version: 10.2 Screen ID: POPCE

= = Required Field

period listed:

PERIOD OF PERFORMANCE | period
DEFAULTS MENU

Period of Performance Defaults Management

of Performance successfully updated

The Period of Performance Default Detail screen appears with your new

USEr: ABILAIL ALABAMA (ALA)
Version: 10.2 Screen ID: POPD

£

~ ACTIONS
Create 1
Delets Search Criteria Reset all Search Fields
Fier crtais:
» SYSTEM OPTIONS Filter on: I ~| v
Summary
Line Items Sexrah
OTHER SYSTEMS Result Sorted By: Default Begin Date Ascending
Mark All Unmark All
e vy Displaying 1-2/ 2
Default Default Total
Mark Period % Begin % End e * Calendar/Work Days % Assigned %
Date Date 4
] Base Period 09/01/2021 08/31/2022 365 Calendar No
[C] aption period Calendar Mo

CIXI I LT

» Edit Option Period dates like you did with the Base Period dates

Displaying 1-2/ 2
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Step

Action

9

The Period of Performance Default Detail screen appears with your new
period listed:

Default Default Total
Mark Period # Begin # End # 3 Calendar/Work Days % Assigned
Days
Date Date

[[] Base Period 09/01/2021 08/31/2022 365 Calendar No
] option Period 08/01/2022 08/31/2023 365 Calendar Mo

If you need additional options, you can create them.
When finished adding your Period of Performances:
» Click Line Items from the Menu Options

10

The Requisition Line Item Detail screen appears:
From the Administration view tab (Line 0001):

> Enter the Qty (i.e. 12)

» Enter the Ul (i.,e. MONTHS)

» Enter the Cost (i.e. 1800)
>

Enter the Description (i.e. BASE YEAR JANITORIAL SVCS NON-
PERSONAL TO FURNISH ALL LABOR, MATERIALS AND EQUIPMENT
NECESSARY TO PERFORM SERVICES IN ACCORDANCE WITH SOW
ATTACHED)

» Enter the Receiving Office Number (i.e. copy an Address Code)
» Click on the Address view tab

From the Address view tab:

» Verify addresses are correct

» Click Apply

» Click the Option tab
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Step Action
11 From the Option view tab (Line 0001):
Requisition Line Item Detail \LlesgcrfE}?élL;IEfeBQrE’&ffD

REQUISITION LINE ITEM
DETAIL MENU = = Required Field
e ICRIREESEC NS, crtion

Accounting Option
e ra— Begin Date  — period End Date:  —

Summary Save Apply Reset Cancel

OTHER SYSTEMS
» Choose the Option (i.e. Base Period) — Dates will automatically fill in from
what you had from the Period of Performance
Requisition Line Item Detail \LlesgcrfE}?élL;IEfeBQrE’&ffD

REQUISITION LINE ITEM

DETAIL MENU = = Required Field
e it e i fdiss gy Option
e — [z % period End Date: [@Emz %

Summary Save Apply Reset Cancel

OTHER SYSTEMS
> Click Apply
» Click Accounting from the Menu Options
12

The Account Code Management screen appears:

Click Create from the Menu Options

Click the “Import Entire Account Code” link
Select a Personal Account Code

Change Object Class to 25272535

Select Allocation By (i.e. Cost)
Enter Cost (i..21600.00)
Enter Quantity (i.e.12)

Click Save
Click Create CLIN from the Menu Options

YV V V V VVVY
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Step

Action

13

The Requisition Line Item Detail screen appears:
From the Administration view tab (Line 0002):

> Enter the Qty (i.e. 12)

» Enter the Ul (i.,e. MONTHS)

» Enter the Cost (i.e. 1800)
>

Enter the Description (i.e. OPTION YEAR 1 - JANITOR SERVICES -
SPECS IN ATTACHED SUPPORT DOC)

» Enter the Receiving Office Number (i.e. copy an Address Code)
» Click on the Address view tab

From the Address view tab:

» Verify addresses are correct

» Click Apply

» Click the Option tab

14

From the Option view tab (Line 0002):

» Choose the Option (i.e. Option Period) — Dates will automatically fill in from
what you had from the Period of Performance

» Click Apply
» Click Summary from the Menu Options
» Click Forms from the Menu Options

Notes:

v Option periods do not have any accounting associated to them

15

The Requisition Form Setup screen appears:

» Click the Accounting Codes checkbox

» Click the Cost of Line Item Applied to the Account Code checkbox
» Click the Delivery Date checkbox

» Click View Form

A warning message will appear.

» Click OK
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Step Action
16 A new window opens showing your requisition form in Adobe (pdf) format. You
can then print or save your document.
» Close out the window.
» Click Save
17

The Requisition Summary screen appears. For training purposes, you're
done. In production you would still finish all the steps.
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Exercise #10: Create a Modification Requisition (Change ACCS -

Add New Line)

Objectives: ¢ Navigate through C.Request

e Create a modification requisition
e Understand how to change ACCS for an award modification
¢ Understand how to add an additional line

e Follow flow chart

Instructions:  Execute the following steps:

After the requisition was sent over and awarded, you find out that your office wants to
add a new additional line to the award and change the accounting for the two existing

lines.
Step Action
1 Locate the requisition through Hotlist, Recently Access, and/or Worksheet tab.
Open the document. For training purposes, you’re going to look for your
Exercise 8 — Cell phone.
2 From the Requisition Summary screen do the following:
» Click Copy from the Menu Options.
3

The Requisition Document Duplicate screen appears.

isiti i User: ABIGAIL ALABAMA (A
Requisition Document Duplicate ._E,Smf: 102 Boreen 1ot DOCD
REQUISITION SUMMARY
MENU = = Required Ficld
+ SECTIONS Copy From
Summary
Administration
Accounting Document Number: NA-AJ2000-21-00010
Line Items
Forms Document Name: 20201005 CELLPHONE
Notes
+ PROPERTIES
Sharing Copy To
Locking
+ PROCUREMENT Dacumant Number: - [A2000 ~] - - [

Period of Performance Defaults
Support Documents Suffix:
History

~ ACTIONS * Document Name: NA-AJ2000-21-2227?
Assign PIIN

Delete Save Reset Cancel
Add to Hotlist

» Choose Document Number from the PICKLIST

GA)
DUP
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Step Action

» Change the Document Name if you wish (i.e. [date] MOD TO CELL PHONE)
» Click Save

The Requisition Administration screen appears. Make any changes that are
needed on this screen. When finished do the following:

» Validate all fields and make changes where necessary (i.e. Delivery Date)

» Enter the Purpose. (i.e. MODIFICATION TO AWARD # TO CHANGE
ACCOUNTING FOR LINES 1-2 AND ADD NEW LINE 3)

» Click Save
» Add to Hotlist
» Click Line Items from the Menu Options

Notes:

v Depending upon when the modification is taking place, other fields may need to
be updated like dates and codes.

v In production, if you know the award number, enter it on the contract number
field.

The Requisition Line Item Management screen appears:
» Click 0001 from the Line ltems to edit it

The Requisition Line Item Detail screen appears.
» Change Modification LI Action to Change Award Line Item

Modification LI Action: Change Award Line ltem v

» Click Apply
» Click on Accounting
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Step

Action

7a

The Requisition Line Item Account Code Management screen appears:

ACCOUNT CODE MENU

~ ACTIONS
Create

Edit

Delete

~ SYSTEM OPTIONS

Summary
Line Items

+ OTHER SYSTEMS

YV V. V V VVVVYY

Requisition Line Item Account Code Management Vot 103 Soen 1Dy RAG
Line Item No.: 0001, CELL PHONE SERVICE $60/MO FOR YEAR STARTING ON DATES LISTED IN SOW
Search Criteria Reset all Search Fields
Search
Line Item Total: 720.00 Total Cost: $720.00 Total Percent: 100% Total Quantity: 1.00
Result Sorted By: Account Code
Mark All || Unmark All
Displaying 1-1 /1
ZJ KR D3 T isplayi /
Mark Account Code * Cost * Quantity * Percent * BOC *
[0 1421281 FF28B0000010221160013021000200000000: 000000 $720.00 1.00 100
isplaying 1 -
C7 KR ) Displaying 1-1/1

Take note of the current accounting especially the object class code
Click Create from the Menu Options

Click the “Import Entire Account Code” link (i.e. use the “new” code)
Select a Personal Account Code

Change Object Class to 23382535

Select Allocation By (i.e. Cost)
Enter Cost (i.e.720.00)

Enter Quantity (i.e.1)

Click Save
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Step

Action

7b

The Requisition Line Item Account Code Management screen appears:

Mark Account Code 4+ Cost $ Quantity # Percent 4+ BOC $
[] 142128LEF28B0000010221160013021000200000000 535000000 $720.00 1.00 100
[l 142128 EF29P000001022116001303100020000000023382525000000 $720.00 1.00 100
[l Displavina1-2 /2

Both codes are now on the line. It's time to make sure the correct information is
there before doing the following steps:

» Write/copy the original code

» Check the box before the original code
» Click Delete from the Menu Options

» Click OK from the pop-up

The screen will come back with only one accounting and a message stating the
other accounting has been deleted successfully.

User: ABIGAIL ALABAMA (AGA)

Requisition Line Item Account Code Management Version: 10.2  Sereen [0 RAC
ACCOUNT CODE MENU Line item account code 1421261 EF28B000001022116001302100020000000023382535000000 was deleted successfully.
+ ACTIONS
Create 4
Edit
Delete Line Item No.: 0001, CELL PHONE SERVICE $60/MO FOR YEAR STARTING ON DATES LISTED IN SOW
Svufr:as;{,m OPLIONS Search Criteria Reset all Search Fields
~ OTHER SYSTEMS
search
Line Item Tetal:  720.00 Tetal Cost: $720.00 Total Percent:  100% Total Quantity: 1.00
Result Sorted By: Account Code
Mark All Unmark All
EIRR 2 Displaying1-1/1
Mark Account Code % Cost s Quantity * Percent + BOC +
[J 142128l EF29P0000010221160013021000200000000 000000 $720.00 1.00 100
ZIRI DT Displaying1-1/1

» Click Line Items from the Menu Options
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Step

Action

8a

The Requisition Line Item Management screen appears:

Click 0002 from the Line Items to edit it
Change Modification LI Action to Change Award Line Item

Click Apply

Click on Accounting

Take note of the current accounting especially the object class code
Click Create from the Menu Options

Click the “Import Entire Account Code” link (i.e. use the “new” code)
Select a Personal Account Code

Change Object Class to 23382535

Select Allocation By (i.e. Cost)
Enter Cost (i..200.00)

Enter Quantity (i.e.1)

Click Save

YV V V V VVVVVY VYV VYV

8b

The Requisition Line Item Account Code Management screen appears with
both codes showing. It's time to make sure the correct information is there
before doing the following steps:

» Write/copy the original code

» Check the box before the original code
» Click Delete from the Menu Options

» Click OK from the pop-up

The screen will come back with only one accounting and a message stating the
other accounting has been deleted successfully.

» Click Line Items from the Menu Options
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Step

Action

9

The Requisition Line Item Detail screen appears:

From the Administration view tab (Line 0001):

YV V V V V V

Enter the Qty (i.e. 1)

Enter the Ul (i.e. EA)

Enter the Cost (i.e. 338.00)

Enter the Description (i.e. CELL PHONE)

Enter the Receiving Office Number (i.e. copy an Address Code)
Click on the Address view tab

From the Address view tab:

» Verify addresses are correct

>
>

Click Apply
Click Accounting from the Menu Options

Notes:

v On a new line being added to an Award you leave the Modification LI Action
blank.

10

YV VV V V V VVVYVY

Click Create from the Menu Options

Click the “Import Entire Account Code” link (i.e. use the “new” code)
Select a Personal Account Code

Change Object Class to 23382535

Select Allocation By (i.e. Cost)
Enter Cost (i..338.00)
Enter Quantity (i.e.1)

Click Save
Click Summary from the Menu Options

Click Accounting from the Menu Options
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Step

Action

11

The Account Code Summary Management screen appears:

Click Create from the Menu Options

Enter the ACCS code that was used on the original award
Uncheck the Default checkbox

Enter the Default percentage to 100%

Click Save

Click Summary from the Menu Options

YV VVVYVYYVYYVY

Click Forms from the Menu Options

12

The Requisition Form Setup screen appears:

» Click the Accounting Codes checkbox

» Click the Cost of Line Item Applied to the Account Code checkbox
» Click the Delivery Date checkbox

» Click View Form

A warning message will appear.

» Click OK

13

A new window opens showing your requisition form in Adobe (pdf) format. You
can then print or save your document.

» Close out the window.
» Click Save

14

The Requisition Summary screen appears. For training purposes, you're
done. In production you would still finish all the steps.
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Exercise #11: Create a Modification Requisition (Cancel Lines on an
Award)

Objectives: ¢ Navigate through C.Request
e Create a modification requisition
¢ Understand how to cancel lines for an award modification

e Follow flow chart

Instructions:  Execute the following steps:

An Award was issued for servicing of a SEACAT.

Step Action

1 Locate the requisition through Hotlist, Recently Access, and/or Worksheet tab.

Open the document. For training purposes, you’re going to look for your
Exercise 7 — SEACAT.

2 From the Requisition Summary screen do the following:
» Click Copy from the Menu Options.
3 The Requisition Document Duplicate screen appears.
» Choose Document Number from the PICKLIST
» Change the Document Name if you wish (i.e. [date] MOD TO SEACAT)
» Click Save
4

The Requisition Administration screen appears. Make any changes that are
needed on this screen. When finished do the following:

» Validate all fields and make changes where necessary (i.e. Delivery Date)

> Enter the Purpose. (i.e. UPDATING AWARD TO CANCEL LINES 5 & 6.
LINE 5 TO USE AGAIN ON ANOTHER AWARD. LINE 6 TOTALLY
CANCELLING NOT USING AGAIN)

» Click Save
Add to Hotlist
» Click Line Items from the Menu Options

Y
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Step

Action

Notes:

v Depending upon when the modification is taking place, other fields may need to
be updated like dates and codes.

v In production, if you know the award number, enter it on the contract number
field.

The Requisition Line Item Management screen appears:

LT S q an 5 PR LI
Mark # % Description * Qty $ UI % Cost # Option % Pricing % Action # Status
[] 0001 COMNFIRM/RECERTIFY SBE28... 5.00 EA 170.00 N/A N/A Unsubmitted
(] 0002 CALIBRATE CONDUCTIVITY/PRESSURE... 5.00 EA 495.00 N/A /A Unsubmitted
] o003 ggg;IERM".RECERTIFY Sz EgUP AER 1.00 LO 4,410.00 N/A NfA Unsubmitted
) ooo4 g?’lg:_IERM".RECERTIFY SBE EQUIP PER 1.00 LO 5,275.00 N/ N/ Unsubmitted
[J ooos gﬂgiIERMJRECERTIFY SBHELULEER 1.00 1B 5,485.00 N/A N/A Unsubmitted
o COMFIRM/RECERTIFY 11/11PLUS;
[l 0006 PERFORM MINOR REPAIRS - SEE 1.00 IB 793.00 N/A N/A Unsubmitted
QUOTE...

» Check the boxes for Lines 1-4
» Click Delete from the Menu Options
» Click OK from the pop-up

The screen will come back with lines 5 and 6 and a message stating the other
line has been deleted successfully.

User: ABIGAIL ALABAMA (AGA)

Requisition Line Item Management Version: 10.2 Screen ID: RLIM
REQUISITION LINE ITEM | |ine Item 0001 deleted successfully.
MENU Line Item 0002 deleted successfully.
Line Item 0003 deleted successfully.

+ ACTIONS Line Item 0004 deleted successfully. Phd
Create CLIN
Croate SUbCLIN Search Criteria Reset all Search Fields
Copy -
Contel Filter on [ ~] ~] |
Delete

TOOLS
Global Replace Search

Renumber Single
Renumber Range

period of Performance Result Sorted By: Line Item No.

IMEORTS, Mark All | Unmark All
From Any Document
Spreadsheet
Check Import Stat . .
o<k mport St B view Line rtem Totals  view Conformed Requisition Line Items Displaying 1-2/ 2
LI P - e - PR LI
EXPORTS
W Mark * $ Description % Qty # UI % Cost $ Option % Pricing % Action # Status
[J ooos ggg_?ERWRECERTIFV SBE EQUIP PER 1.00 1B 5,485.00 N/A N/A Unsubmitted
» SYSTEM OPTIONS o CONFIRM/RECERTIFY 11/11PLUS;
Summary [J 0006 PERFORM MINOR REPAIRS - SEE 1.00 1B 793.00 N/A N/A Unsubmitted
QUOTE...
OTHER SYSTEMS
I DT Displaying 1-2 / 2

> Click 0005 from the Line ltems to edit it
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Step

Action

6

The Requisition Line Item Detail screen appears.

» Change Modification LI Action to Cancel/Open Award Line Item

Modification LI Action: Cancel/Cpen Award Line ltem v

> Click Save

The Requisition Line Item Management screen appears:
» Click 0006 from the Line ltems to edit it

The Requisition Line Item Detail screen appears.

» Change Modification LI Action to Cancel/Cancel Award Line Item

Modification LI Action: Cancel/Cancel Award Line ltem ~

> Click Save

Notes:
v

v

The Cancel/Open option will cancel it from the award, but leave it open to be put
on another one.

The Cancel/Cancel option will cancel it from the award and de-obligate the
money.

The Requisition Line Item Management screen appears:

User: ABIGAIL ALABAMA (AGA)

Requisition Line Item Management Version: 102 Screen ID; RLIM

REQUISITION LINE ITEM | |jna Item successfully updated.

MENU

~ ACTIONS
Create CLIN
Create SubCLIN
Copy

Cancel

Delete

- TOOLS
Global Replace

Renumber Single
Renumber Range

Period of Performance

4

Search Criteria Reset all Search Fields

Filter on: [ ~] ] [

Search

Result Sorted By: Line Item No

mul MEORLS, Mark All | Unmark All
From Any Document
Spreadsheet
Check Import Status i i
2 EIR DT View Line Item Totals _View Conformed Requisition Line Items Displaying1-2/ 2
LI P - - " PRLI
~ EXPORTS Mark @ Description & 4+ UL & Cost 4 oOption ¢ pricing ¢ Action @
Spreadsheet = " 7 P 9 S LIS
O ooos gﬁg%RM/RECERTIFY SBE EQUIP PER 1.00 1B 5,485.00 N/A N/A Cancel/Open Unsubmitted
~ SYSTEM OPTIONS . CONFIRM/RECERTIFY 11/11PLUS;
Summary [l 0006 PERFORM MINOR REPAIRS - SEE 1.00 B 783.00 N/A MN/A Cancel/Cancel Unsubmitted
QUOTE..
~ OTHER SYSTEMS
b vy Displaying 1-2/ 2

» Click Summary from the Menu Options

» Click Forms from the Menu Options
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Step

Action

10

The Requisition Form Setup screen appears:

» Click the Accounting Codes checkbox

» Click the Cost of Line Item Applied to the Account Code checkbox
» Click the Delivery Date checkbox

» Click View Form

A warning message will appear.

» Click OK

11

A new window opens showing your requisition form in Adobe (pdf) format. You
can then print or save your document.

» Close out the window.
> Click Save

12

The Requisition Summary screen appears. For training purposes, you're
done. In production you would still finish all the steps.
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Exercise #12: Create a Modification Requisition — Exercising Option
Period

Objectives: e Navigate through C.Request
¢ Create a Requisition to Exercise Option Period
e Copy previous requisition
e Use the Option View Tab

e Follow flow chart

Instructions:  Execute the following steps:

Your office still needs janitorial services for your location(s). You will need to create a
requisition to exercise the option year already contained on the initial contract. You
will copy the original requisition, delete the original base line, and make changes to the
option line.

Step Action

1 Locate the requisition through Hotlist, Recently Access, and/or Worksheet tab.
Open the document. For training purposes, you’re going to look for your
Exercise 9 — JANITOR

2 From the Requisition Summary screen do the following:
» Click Copy from the Menu Options.

3 The Requisition Document Duplicate screen appears.
» Choose Document Number from the PICKLIST

» Change the Document Name if you wish (i.e. [date] MOD TO EXERCISE
OPT1)

» Click Save
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Step

Action

4

The Requisition Administration screen appears. Make any changes that are
needed on this screen. When finished do the following:

» Validate all fields and make changes where necessary (i.e. Delivery Date)
» Enter the Purpose. (i.e. MOD TO EXERCISE OPTION PERIOD 1)

» Click Save

» Add to Hotlist

» Click Line Items from the Menu Options

Notes:

v’ If there is a FCOTs number associated to this line and it's been a year,
please make sure to verify the number is still correct or if a new one needs to
be added.

The Requisition Line Item Management screen appears with all CLINSs:

User: ABIGAIL ALABAMA (AGA)

Requisition Line Item Management Version: 10.2 Screen ID: RLIM

;ESSISIT[ON LINE ITEM Search Criteria Reset all Search Fields

— Filteron: [

Create CLIN
Create SubCLIN
Copy

Cancel

Delete

~] o

Search

- TOOLS Result Sorted By: Line Item No.

Global Replace
Renumber Single Mark All  Unmark All
Renumber Range

Period of Performance

Bkl view vine ttem Totals view Conformed Requisition Line Items Displaying 1 -2/ 2
PR LI
Status

+ IMPORTS
From Any Document Mark
Spreadsheet =
Check Import Status . BASE YEAR JANITORIAL SVCS NON-

[J 0001 PERSOMAL TO FURNISH ALL LABOR, 12.00 MO 1,800.00 Base Period N/A Unsubmitted
- EXPORTS MATERIALS AND EQUIP..
Spreadsheet 0 OPTION YEAR 1 - JANITOR SERVICES —

0002 SPECS IN ATTACHED SUPPGRT DOC... 12.00 MO 1,800.00 Option Peried N/A Unsubmitted

« SYSTEM OPTIONS (<[] Displaying 1-2/ 2
Summary

. Description ¢ Qty ¢ ur @ Cost ¢ option & Pricing ¢ Action ¢

« OTHER SYSTEMS

» Click Mark checkbox for Line 0001
» Select Delete from the Menu Options
» Click OK from the message prompt
» Click 0002 from the Line Items to edit
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C.Request for New Users

Training Exercises

Step

Action

6

The Requisition Line Item Detail screen appears:
» Change the Modification LI Action to:

Modification LT Action: | Change Award Line ltem

» Click the Option tab

Requisition Line Item Detail

REQUISITION LINE ITEM
DETAIL MENU

0 iU OPtion
Accountin -
9 Qption: Option Period v

Create SUbCLIN Period Begin Date:

09/01/2022 &

Line Items
Summary

Save Apply Reset

F

» Change the option to “blank”
» Delete the Period Begin and End Dates

Requisition Line Item Detail

REQUISITION LINE ITEM
DETAIL MENU

Period End Date:

Cancel

0 U OPtion
Accounting .
option:
Create SUBCLIN period Begin Date :rﬁ’ Period End Date:

Line Items
Summary

Save  Apply Reset

= OTHER SYSTEMS

» Click Apply
» Click Accounting

Cancel

User: ABIGAIL ALABAMA (AGA)
Version: 10.2 Screen ID: RLID

= Required Field

08/31/2023 &

User: ABIGAIL ALABAMA (AGA)
Version: 10.2 Screen ID: RLID

= = Required Field
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Training Exercises

Step

Action

8

The Requisition Line Item Account Code Management screen appears:

ACCOUNT CODE MENU

~ ACTIONS
Create

Edit

Delete

» SYSTEM OPTIONS
Summary
Line Items

+ OTHER SYSTEMS

Requisition Line Item Account Code Management

Line Item No.: 0002, OPTION YEAR 1 - JANITOR SERVICES a€" SPECS IN ATTACHED SUPPORT DOC

User: ABIGAIL ALABAMA (AGA)
Version: 10.2 Screen ID: RAC

Search Criteria

Search Criteria | ~] | v |

Search

Reset all Search Fields

Line Item Total: 21600.00 Total Cost: $0.00 Total Percent: 0%

Result Sorted By: Account Code
Mark All | Unmark All

Mark Account Code % Cost

Total Quantity: 0.00

s

Quantity $

Displaying0-0/ 0
Percent L BOC @

Mo Account Code records found that meet the filter criteria

» Select Create from the Menu Options

Displaying0 -0/ 0

The Account Code Detail screen appears.

YV V. V V V V

Import your Personal Account Code
Change the Object Class if needed (i.e. 25272535)
Select Allocation By (i.e. Cost)
Enter the Cost (i.e.21600)
Enter the Quantity (i.e.12)
Click Save

10

YV V. V V V

Verify the Line Item Total equals Total Cost
Verify the Total Percentage equals 100%

Click Summary from the Menu Options
Click Forms from the Menu Options

Verify the Total Quantity equals the total line item quantity
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Step

Action

Notes:

v In production, you would use the FY for when the option period would be
exercised for both the Document Number as well as the Accounting. (i.e. FY 20
or FY 21).

v’ Option periods can be years or they can be months within a year.

V" In Training, we are limited to only the current FY.

11

The Requisition Form Setup screen appears:

» Click the Accounting Codes checkbox

» Click the Cost of Line Item Applied to the Account Code checkbox
» Click the Delivery Date checkbox

» Click View Form

A warning message will appear.

» Click OK

12

A new window opens showing your requisition form in Adobe (pdf) format. You
can then print or save your document.

» Close out the window.
» Click Save

13

The Requisition Summary screen appears. For training purposes, you're
done. In production you would still finish all the steps.
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Exercise #13: Create a Modification Requisition — To De-Obligate
Funding

Objectives: e Navigate through C.Request
e Create a Requisition to de-obligate funding
e Copy previous requisition

e Follow flow chart

Instructions:  Execute the following steps:

Notes:

e Any modifications to awards are always done with a new requisition. However,
the new requisition must have the same line number(s) as the original award.

e The new requisition must have zero dollar amounts on the line. You need to
enter the amount you want de-obligated in the description along with any amount
that has already been paid into the Commerce Financial System (CFS) along
with the ACCS Strings that need to be de-obligated. Modification LI Action must
be filled out correctly.

e The FMC Obligation Query in Discoverer can be used to find the de-obligation
and paid amounts.

The original requisition was sent to acquisitions, awarded and obligated. Not all of the
funds were used, so you will need to create a new requisition to de-obligate those

funds. There are different reports to be used in figuring out what is left to de-obligate.
Depending on the situation, an AGO officer may end up sending you the details of the

requisition you need to create, or you can run the FMC Obligation Discoverer
Workbook.

Step Action

1 After running the report or getting something from the budget or AGO office, you
see that you need to de-obligate the left-over amount.

2 Locate the requisition through Hotlist, Recently Access, and/or Worksheet tab.

Open the document. For training purposes, you’re going to look for your
Exercise 4 — PRINTER
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Step

Action

4

From the Requisition Summary screen do the following:

>

Click Copy from the Menu Options.

The Requisition Document Duplicate screen appears.

>
>
>
>

Choose Document Number from the PICKLIST
Change the Document Name (i.e. [date] DEOB PRINTER )

Click Save

The Requisition Administration screen appears. Make any changes that are
needed on this screen. When finished do the following:

>

>
>
>

Enter the Purpose. You should include the information that you are de-
obligating money.

Click Save
Add to Hotlist
Click Line Items from the Menu Options

The Requisition Line Item Management screen appears with all CLINSs:

>

Click 0001 from the Line Iltems to edit it

The Requisition Line Item Detail screen appears.

>
>
>

Change Modification LI Action to Change Award Line Item
Change the Cost to the zero for the line (i.e. 0.00)

In the Description field enter the amount to be de-obligated (-209.28),
Amount paid (1156.89) and ACCS code(s) the amount needs to being de-
obligated from. Because you are creating a $0 requisition, this is the only
place this information is captured.

Click Apply
Click on Accounting
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Step

Action

Notes:

Negative amounts are not allowed in the cost field. De-obligation and paid
amounts should be entered in the description only.

No ACCS is necessary on the requisition if cost for the line is set to $0.

Since no ACCS is necessary for a $0 requisition, before deleting it off this
requisition, copy the string(s) to add to the description line prior to deleting any
ACCS strings.

FY 2021 — Version 1.0 119
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Training Exercises

Step

Action

9

The Requisition Line Item Account Code Management screen appears:

ACCOUNT CODE MENU

Create
Edit
Delete

Requisition Line Item Account Code Management

Line Item No.: 0001, AMT PAID $1156.89
DE-OB AMT -$209.28
ACCS:1421281LEF28B000001022116001302100020000000026182535000000

User: ABIGAIL ALABAMA (AGA)
Version: 10.2 Screen ID: RAC

[+ SYSTEM OPTIONS [ Search Criteria

Summary
Line Items

= OTHER SYSTEMS

» Copy the

Search Criteria ~] | ] | |

Search

Reset all Search Fields

Line Item Total: 659.00 Total Cost: $659.00 Total Percent: 100% Total Quantity: 100.00
Result Sorted By: Account Code
Mark All | Unmark All
Ll i) Displaying1-1 /1
Mark Account Code + 4 Quantity @ Percent # BOC *
O 142128 EF28B000001022116001302100020000000026182535000000 $659.00 100.00 100

ACCS string(s) that will be used

» Check the Mark checkbox in front of the ACCS
> Click Delete

> Click OK

ACCOUNT CODE MENU

Create
Edit
Delete

Summary
Line Items

Requisition Line Item Account Code Management

Displaying1-1/ 1

User: ABIGAIL ALABAMA (AGA)
Version: 10.2 Screen ID: RAC

Line item account code 142128LEF28B000001022116001302100020000000026182535000000 was deleted successfully.

Line Ttem No.: 0001, AMT PAID $1156.89
DE-OB AMT -$209.28
ACCS5:142128LEF28B000001022116001302100020000000026182535000000

OTHER SYSTEMS Search Criteria

Search Criteria [ v] ‘ v| | |

Search

Reset all Search Fields

Line Item Total:  655.00 Total Cost: 50.00 Total Percent: 0%
Result Sorted By: Account Code

Mark All | Unmark All
ZIENDICT

Mark Account Code * Cost

Total Quantity: 0.00

Displaying0-0 /0

® Quantity ¢ Percent ¢ BOC ¢

No Account Code records found that meet the filter criteria

» Click Line Items from the Menu Options

Displaying0-0/ 0
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Step Action

10 | The Requisition Line Item Management screen appears with all CLINs:
» Click 0001 from the Line Items to edit it

11 The Requisition Line Item Detail screen appears.
» Paste the ACCS string(s) that will be de-obligated

AMT PAID $1156.89

DE-OB AMT -$209.28
ACCS:142128LEF28B00000102211600130210002000000
0026182535000000 -

» Click Save
» Click Summary from the Menu Options
» Click Forms from the Menu Options

12 | The Requisition Form Setup screen appears:

» Click the Accounting Codes checkbox

» Click the Cost of Line Item Applied to the Account Code checkbox
» Click the Delivery Date checkbox

» Click View Form

A warning message will appear.

» Click OK

13 | A new window opens showing your requisition form in Adobe (pdf) format. You
can then print or save your document.

» Close out the window.
» Click Save

14 | The Requisition Summary screen appears. For training purposes, you're
done. In production you would still finish all the steps.

FY 2021 — Version 1.0 121



C.Request for New Users Training Exercises

Step Action

Notes:

v Since you can export the FMC Obligation Discoverer report as an excel
document, it might be helpful to attach it to the requisition for the Contracting
Specialist as a support document.
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